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ABSTRACT 

DETERMINATION OF STREAM FLOW CHARACTERISTICS OF 

HELMAND REGION USING BASIN 

PHYSIOGRAPHIC PARAMETERS 

MSC THESIS 

ROHULLAH RAHIMI 

PAMUKKALE UNIVERSITY INSTITUTE OF SCIENCE 

CIVIL ENGINEERING 

(SUPERVISOR: ASSOC. PROF. FATİH DİKBAŞ) 

DENİZLİ, AUGUST 2021 

 

This study aimed to find linear relationships to calculate the long term mean 

discharge and the maximum instantaneous discharge values for the Afghanistan 

Helmand Region Basin streams. Linear equations including the basin 

physiographic parameters obtained from the Digital Elevation Model (DEM) have 

been determined. For this study, 11 basins from the Afghanistan Helmand Region 

Basin were selected and all were contained from the 30 meters (1 angular second) 

SRTM DEM within the scope of this thesis. For each basin 30 physiographic 

parameters were calculated for 11 basins area, perimeter, average basin altitude, 

average basin slope, distance between basin center of gravity and basin exit point, 

elevation of basin flow observation station, basin elevation-relief ratio, minimum 

and maximum profile curvature of the extracted DEM of the basin, Strahler and 

Shreve bifurcation amounts, the length of the main stream, the straight length 

between the basin main stream starting point and the basin exit point, ratio 

between the length of the main stream and the straight length between the basin 

main stream starting point and the basin exit point (sinusoity), X and Y 

coordinates of basin center of gravity, basin flow observation station X and Y 

Coordinates with the ratios obtained from the aspect map of the basin elevation. 

By using the Backward Stepwise Multiple Linear Regression Method, relationship 

between the flow characteristics and physiographic parameters were obtained. 

Goodness of fit of the models was evaluated with determination coefficient, 

adjusted determination coefficient and standart error of estimate. 
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1. GİRİŞ 

1.1 Tezin Amacı  

Bu tez çalışmasında, Afganistan’nın Helmand Bölgesi akarsularının akım 

karakteristiklerinin havza fizyografik parametreleri ile belirlenmesi 

amaçlanmaktadır. ArcGIS’te kelimenin tam anlamıyla yüzlerce araç vardır ancak 

bunlara aşina olmamıza rağmen hepsiyle çalışmak mümkün değildir. Bu belge; 

ilerledikçe haritalar oluşturmak, coğrafi bilgiler aramak ve son olarak iyi 

düzenlenmiş bir harita yayınlamak için beceriler edinebileceğimiz veya sahip 

olduklarımızı geliştirebileceğimiz şekilde tasarlanmıştır. 

Bu tezin amaçlarından birisi de, haritalama sürecinin tamamını içeren havza 

fizyografik parametrelerinin belirlenmesi ve geliştirilmesi için temel Coğrafi Bilgi 

Sistemi (CBS) kavramlarını tanıtmaktır. Su kaynakları mühendisliğinde ve havza 

yönetiminde CBS kullanımı 1970’lere kadar gitmektedir. Fizyografik analiz, ilgili 

bölgeden elde edilen fizyografik parametreleri, büyüklük ve dağılım açısından 

araştırmaktadır. Havzaların fizyografik parametreleri, bunların ayırt edici 

özellikleridir ve havza modelleme çalışmalarında diğer hidrolojik ve meteorolojik 

parametrelerle birlikte kullanılmaktadır. Helmand Bölgesindeki nehirler, yüksek 

dağlardan gelen akarsu akımının büyüklüğü ve zaman dağılımı bilgisi su yönetimi ve 

çevre planlamasının tüm yönleri için esastır.  

Afganistan’ın yüzey suyu kaynaklarının geliştirilmesinden ve yönetiminden 

sorumlu makamların, her havzaya ait akarsu akım bilgileri güvenli bir şekilde 

ekonomik ve çevreye duyarlı su kaynakları planlaması için kullanılmıştır. Bu alanda 

sorumlu makamların gerekli akarsu akım bilgilerini sağlamak için ABD Uluslararası 

Kalkınma Ajansı ile işbirliği içinde ABD Jeolojik Araştırma birimiyle Helmand 

Bölgesi içindeki akım gözlem istasyonlarında toplanan veriler kullanılarak akarsu 

akımı istatistikleri hesaplanmıştır. 

Bu çalışmanın diğer bir amacı, uzun vadeli sürekli akım kayıtlarına sahip 

havzalarda seçilen akım özelliklerindeki değişiklikleri tanımlamak için kapsamlı bir 

prosedür dizisi sunmaktır. Bu çalışmada 2001-2020 dönemi için Afganistan’ın üst 
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Helmand Nehri’nden alınan akım verileri kullanılmıştır. Helmand Bölgesi için 

Kajaki Barajı’nın yukarısında akarsu akım yönündeki tüm tarihi gözlem istasyonları 

için akarsu akım özelliklerini özetleyen kapsamlı bilgiler sağlanması amçlanmıştır. 

Helmand Bölgesi’nden seçilen 11 havzanın ortalama ve maksimum debiler ile 

havzaların fizyografik parametreleri arasında çoklu doğrusal regresyon analizi 

yapılmıştır. Bölge havzalarının gözlem istasyonları Tablo 2.1’de listelenmiştir ve 

yerleri Şekil 2.1’de gösterilmiştir. 

CBS, on yıllardır, arazi ve doğal kaynak yönetimi, çevre sorunlarına, askeri 

lojistiğe veya coğrafya, jeoloji vb. gibi yer bilimleriyle doğrudan bağlantılı 

bağlamlarda uygulanmaktadır. Ayrıca CBS, diğer nispeten  araştırılmamış alanlar 

için potansiyel bir kullanım alanıdır. Özellikle insan ve sosyal bilimler ile ilgili 

araştırmalar ve disiplinlerde kullanılmıştır (Del Bosque González vd, 2018). CBS, 

sayısal bilgileri yakalamamıza, depolamamıza, yönetmemize ve analiz etmemize, 

ayrıca grafikler ve haritalar yapmamıza ve temsil etmemize olanak tanıyan donanım, 

yazılım, veriler ve bir dizi kullanıcılardan oluşan araçtır. Burrough’a (1994) göre 

CBS, belirli bilgi ihtiyaçlarını karşılamak, yani verilere ve haritalara dayalı olarak 

yararlı bilgiler oluşturmak, paylaşmak ve uygulamak için coğrafi gerçekliğin bir 

bilgisayar modeli olarak da görülebilir. 

Bu çalışma, Helmand ili ile ülkenin en kalabalık bölgesini kapsamaktadır. 

Ülkenin en kalabalık ve en büyük bölgesi olan üst Helmand Nehir Bölgesi 

Afganistan’ın batı kesiminde yer almaktadır. Helmand Nehir Bölgesinin su kaynağı 

özellikleri ve aynı zamanda ülkenin en büyük havzası ve en büyük şehri Helmand 

gibi önemli şehirlerindeki su talebi ile ilgilidir. Ayrıca kısa orta ve uzun vadede evsel 

ve tarımsal amaçlı su sağlanması için havzanın akarsularının akım 

karakteristiklerinin belirlenmesi gerekmektedir. 
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1.2 Tezin Konusu ve Literatür Bilgisi  

Helmand Bölge sınırlandırması ve hidrolojik modellemesi için mevcut 

çalışma yoktur. Bir havza veya bölgenin fizyografik parametrelerinin kullanımı 

çeşitli amaçlar için olabilir. Havzaların morfolojik özellikleri sadece hidrolojik 

çalışmalarda değil, jeolojik çalışmalarda da kullanılır. 

Miliaresis ve Iliopoulou, 2004 yılında, Zagros Ranges, İran’ın arazi 

sınıflandırma çalışmasında arazi modellemede, maksimum yükseklik, ortalama 

yükseklik, ortalama gradyan ve hipermetrik integral gibi jeomorfometrik 

parametreler kullanmıştır. Erdağ ve arkadaşları 2009 yılında bir alanın tektonik 

aktivitesinin seviyesini belirlemek için hipermetrik integral, dere uzunluğu - gradyan 

indeksi ve vadi taban genişliği ile vadi yükseklik oranı gibi jeomorfik indeksleri 

kullanmışlardır.  

Shuttle Radar Topography Mission Digital Elevation Model (SRTM-DEM) 

tarafından elde edilen uydu tabanlı yükseklik veri seti, özellikle kentleşmemiş 

alanlarda havza parametrelerinin çıkarılması için güvenilir bir ana veri olarak 

kullanılabilir (Akbari ve ark., 2011).  

CBS tabanlı hidrolojik modellemenin ana girdisi olarak yüksek çözünürlüğe 

sahip SYM, HEC-HMS modelleme girdi verisi üretimi için etkin bir şekilde 

kullanılabilir (Malekani ve ark., 2014). Tunus’ta SYM, ana girdi verisi olarak bir 

CBS ortamında ve Saadine havzasında yağış-akış için Kineros modellemesi yeraltı 

suyu besleme ve sızma alanları için kullanılmıştır (Ali ve ark., 2016). 

CBS hidroloji aracı kullanılarak Türkiye’nin Konya Havza tanımlamasında 

ana veri olarak SYM kullanılmış, akım yönü, akım toplamı ve akım sırası tahmin 

edilmiştir (Al-qaysi, 2016). Toprak sınıflandırması ve ileri inceleme için büyük 

Konya Havzası için bir çalışma yürütülmüştür (De Meester, 1970).  

CBS ile uzaktan algılama, Türkiye'deki Güney Marmara Havzası için SCS 

yüzey akımı CN'sini tanımlamak için kullanılmıştır (Öztürk ve Gül, 2011). 

Türkiye’de Havran nehri havzası SCS CN yağış-akış modellemesi için CBS ve 

uzaktan algılama kullanılarak yapılan bir çalışmada, yağış-akış analizlerinde sadece 

günlük yağış verileri kullanılmış olup, yağışların yanında kar erimeleri ve 
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kaynaklarla akıma dahil olan su hacmi uygulanmamış alt havzalar için iyi bir 

korelasyon göstermiştir (Özdemir, 2007). 

Bazı hidrolojik modelleme çalışmalarında havzaların fiziksel özellikleri ve 

hidrolojik özellikleri birlikte kullanılmaktadır. Berger ve Entekhabi 2001 yılında, 

dağıtılmış fizyografik tanımlayıcılara ve iklime havza hidrolojik yanıt ilişkilerini 

incelemek için ABD’de 10 farklı havzanın jeomorfolojik parametresi olarak medyan 

eğim, rahatlama oranı ve drenaj yoğunluğunu kullanmışlardır. 

Yağış akış simülasyonu; özellikle taşkın azaltma, sulama, drenaj ağı ve 

hidroelektrik enerji üretiminde su kaynakları yönetiminin çeşitli faaliyetlerinde çok 

önemlidir (Rawat ve Singh, 2017). Wadi Al Dawasir Suudi Arabistan kurak havzası 

için paleo-sel ve CBS teknikleri üzerine yapılan bir çalışma, çeşitli hidrolojik 

modeller, paleo-sel ölçümleri ve CBS arasındaki bağlantının, kurak havzaların 

hidrolojik davranışını araştırmak için yararlı bir araç olduğunu öne sürmüştür 

(Masoud ve ark., 2019). 

Sanborn ve Bledsoe, 2006 yılında, bozulmamış akarsuların rejimlerini 

sınıflandıran bir metodoloji sunmuşlardır. ABD’nin üç eyaletinde 150 akım için 

çeşitli akım rejimi özelliklerini karakterize eden 84 akım metriği kullanmışlardır. 84 

havza özelliğinden 20’si ortalama ve minimum yükseklik, drenaj yoğunluğu, 

ortalama eğim ve alan, göllerin yüzdesi, ortalama kanal eğimi, ortalama yönü ve 

farklı jeolojik tiplerin altında yatan havza yüzdesi gibi fizyografik özellikleri 

göstermektedir.  

Türkiye’de Topaloğlu, 2002 yılında, Seyhan Nehri Havzası’ndaki anlık tepe 

akımlarını bölgesel regresyon prosedürlerini kullanarak incelemiştir. Çalışma için 13 

gözlem bölgesi kullanılmıştır. Morfometrik özellikler havza alanı, akım uzunluğu, 

Benson eğimi, akarsu akım frekansı, havza çevresi, havza uzunluğu, çatallanma oranı 

ve maksimum havza rölyefi kağıt haritalardan elde edilmiştir. 

Yağmur suyu hasadı öncelikli bölgeler ve ani sel tehlike uyarı bölgeleri için 

Masoud 2015 tarafından yapılan bir çalışmada, CBS’nin su kaynakları yönetimi ve 

planlamasında karar desteği için yararlı bir araç olarak kullanılabileceği 

bulunmuştur. Yarı kurak bir havzada, UA ve CBS kombinasyonu su kaynaklarının 

korunması ve arazi kullanımı önceliklendirmesi için kullanılırken, alt havzaların 
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öncelik listesinin su kaynakları koruma projeleri için çok önemli olacağı görülmüştür 

(Khanday ve Javed, 2016). Tarım alanlarının önceliklendirilmesi için yarı kurak 

bölgelerde havzaların alt havzalara ayrılması CBS ve UA kullanılarak bu alt 

havzaların önceliklendirilmesi çok önemlidir (Makwana ve Tiwari, 2016). 
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2. MATERYAL VE YÖNTEM  

Bu tez kapsamında yararlanılan ve Helmand Bölgesi’ni kapsayan Sayısal 

Yükseklik Modelleri (SYM), (Veri kaynağı: USGS, hücre boyutu: 30 x 30 m), 

ortalama yıllık yağış verileri (Veri Kaynağı: NWARA ,IWMI ve NOAA), arazi 

örtüsü türleri haritası (Veri kaynağı: UN-FAO ve vektörleştirilmiş haritalar) bilgi ve 

verileri dikkate almanın mükemmel bir yoludur ve (SYM) farklı havza 

karakteristiklerini tanımlamak için kullanılabilir. 

2.1 Çalışma Alanı 

Helmand Nehir Bölgesi Afganistan’nın batı bölgesinde yer almaktadır. 

Yüzölçümüne göre Helmand Nehir Bölgesi Afganistan’nın en büyük nehir 

havzalardan biridir. Helmand Nehir Bölgesi 32º19´17 ̋ - 34º34´28 ̋ K enlemleri ve 

65º07´12 ̋ - 68º16´21 ̋ D boylamları arasında 46600 km
2
’lik bir alana sahiptir. 

Helmand Nehir Bölgesi 11 alt havzaya ayrılmıştır. Alanın yüksekliği ortalama deniz 

seviyesinden 965 m ile 5064 m arasında değişmektedir. Helmand Nehir Bölge alanı; 

büyük tepeler, kumlu vadiler ve çakıllı ovalar tarafından şekillendirilmiştir. Toprak 

yapısı siltli kil, kum ve çakıldan oluşmaktadır. Helmand Nehir Bölgesi Kabil ilinin 

yaklaşık 40 kilometre batısındaki Paghman ilçesinin yakınlarındaki Hindukuş dağ 

silsilesinin batıya doğru bir uzantısında ortaya çıkar ve güneybatı yönünde Kajaki 

barajının rezervuarına yaklaşık 590 kilometre boyunca uzanmaktadır. Helmand Nehir 

Bölgesi, Afganistan'nın batı iklimine sahiptir. Kışlar soğuk, yazlar sıcaktır. 

Yağışların çoğu ilkbaharda yağmur, kış mevsiminde kar olarak düşer. Nehir suyu 

akımı, çoğunlukla kış ve ilkbahar mevsimlerinde havzanın ortalama kotlarındaki 

yağışlardan ve 5064 metreye yükselen yüksek dağlardaki karların erimesinden 

kaynaklanmaktadır. Yıllık yağış yüksekliği 100 mm ile 400 mm arasında değişir ve 

çoğunlukla kış ve ilkbahar aylarında maksimum yağışa ulaşır. Dağlar birçok yerel 

değişime neden olur, ancak Helmand Nehir Bölgesi kuru bir karasal iklim tarafından 

kategorize edilir. Hava sıcaklığı kışın -10°C’den yazın +34°C’ye kadar 

değişmektedir. Çalışma yeri Şekil 2.1’de sunulmaktadır. 
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Bu çalışmada, Helmand Bölgesi’ndeki 11 drenaj havzası incelenmiştir. 

Helmand ili, Afganistan'in batı kesiminde yer almaktadır. İlin batı kısmı, yatay ve 

hafif eğimli tabakalardan aşınmış arazilerle karakterize edilen Kandahar ilinin 

sınırlarına kadar uzanmaktadır. Helmand ilinin doğu sınırı, deniz seviyesinden 3000 

metreden yaklaşık 1000-2000 m yüksekliğe kadar ani düşüşlerle, büyük yamaçlar 

içermektedir. Helmand ilinin doğu kısmı, yaklaşık 3000 metreye kadar kabartmalı 

geniş sırt ve vadi topografyası ile karakterize edilen Yeni Bamyan ilinin sınırlarına 

kadar uzanmaktadır. Altta yatan jeolojik yapılar, çoğunlukla çeşitli yaşlardaki tortul 

kayalardan oluşan aşınmış kıvrımlardır. 

Başlangıçta yaklaşık havza alanı 46600 km
2
’ye kadar 11 adet havza için 11 

adet akarsu akım gözlem istasyonu seçilmiştir. Coğrafi bilgi sistemi ile SYM’lerden 

türetilen havza özellikleri ve yüzey akarsu akımına ilişkin bu çalışmanın sonuçları 

tez çalışması kapsamında regresyon analizinde kullanılmıştır. 

Helmand Bölgesi analizi için USGS Earth Explorer tarafından sağlanan bir 

web sitesinden (https://earthexplorer.usgs.gov/) 24.000 SYM indirilmiştir. Havza 

büyüklüğünün artmasıyla, tamamen Batı Afganistan’da hapsolmuş havzaları bulmak 

gittikçe zorlaşmıştır. Birkaç kusurlu 24K SYM ve bazı eksik 24K SYM’ler, bu 

çalışmada kullanılan havza sayısını daha da azaltmıştır. Nihai veri seti, 155 km
2
 ile 

46600 km
2
 arasında değişen 11 adet havza içermektedir ve Şekil 2.2’de 

gösterilmektedir. 
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Şekil 2.1: Çalışma alanının konumu (FAO, 2012). 

Havza tanımlaması için SYM, 1 ark saniyelik global (yaklaşık 30*30 m) 

çözünürlük ile SRTM’den elde edilmiştir. Çalışma alanı için öngörülen koordinat 

sistemi WGS_1984_UTM_Zone_42N olarak gösterilmektedir. Arazi örtüsü verileri, 

2018’de CORINE (Cordination of Information on The Environment) Arazi Örtüsü 

verilerinden elde edilmiştir. Veriler su havzasına kırpılmış ve havzaya da 

yansıtılmıştır. 

Helmand nehir bölgesi SYM, nehir ağları ve alt havzaları Şekil 2.2’de 

gösterilmektedir. Çalışma alanında en yüksek kot 5064 m ve en düşük kot 965 m’dir. 

SYM’in daha iyi gösterimi için QGIS 3.10 ortamında tepe gölgesi kullanılmıştır. 

Nehir ağları, CBS ortamında arazi işlemede Hydro Tools’dan alınmıştır. Su havzası 

ve alt havzalar arazi işleme ve havza işleme kombinasyonu ile elde edilmiştir, Alt 

havzalar birleştirilerek daha büyük havzalar oluşturulmaktadır. 
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Şekil 2.2: Helmand Bölgesi SYM, nehir ağları ve alt havzaları. 

 

Şekil 2.3: Tez kapsamındaki havzaların akım gözlem istasyonu numaraları ve 

akarsular. 
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2.2 Seçilen Havzalardan Havza Fizyografik Parametrelerini 

Çıkarmak İçin ArcInfo Kullanımının Değerlendirilmesi 

Drenaj ağlarının özellikleri ve drenaj havzası fizyografik parametreleri 

hidrolojik hesaplama ve modellemede yaygın olarak kullanılmaktadır. Alt havza 

tanımlama, işleme ve manipülasyon yeteneğinin vurgusu esneklik, kullanım kolaylığı 

ve kullanıcı etkileşimi üzerinedir. Kullanıcı bir havzayı alt bölümlere ayırdığında 

veya birçok küçük alt havzayı bir araya getirdiğinde, işlemin sonuçları kullanıcının 

onayı için hemen görüntülenir. Alt havza işlemlerini etkileşimli olarak 

gerçekleştirme yeteneği güçlüdür çünkü sonuçlar, verileri yeniden işlemek yerine 

kullanıcının bir modelleme kararı vermesi için hızlı bir şekilde sunulur. Örneğin, 

kullanıcı bir akarsu akım profili, dere, yüzey akışı, drenaj alan boyutu hakkında bilgi 

elde edebilir ve önemli derecede, akarsu türlerini yan kolları sayılarına göre 

tanımlama ve sınıflandırma ayarlayabilir. 

Alt havza işlemlerinde diğer araçlar, istenen çıkışların nokta konumlarını 

içeren bir veri seti sağlayarak kullanıcının toplu modda alt havzaları tanımlamasına 

izin verir. Fiziksel özelliklerin çıkarılmasına ek olarak kullanıcı çeşitli hidrolojik 

parametrelerin başlangıç değerlerini tahmin etme seçeneğine sahiptir. Eğri numarası 

gibi hidrolojik parametreler, toprak ve arazi kullanımı veritabanlarından havza 

ortalaması ve ızgara bazlı miktarlar olarak çıkarılabilir. Toplanma zamanı gibi diğer 

hidrolojik parametreler arazi ve yağış verilerini içeren çeşitli veri kümelerinden 

hesaplanır. 

Otomatikleştirilmiş drenaj ağları üretimi, CBS kullanımı ve Sayısal 

Yükseklik Modellerinin kullanılabilirliği ile giderek daha popüler hale gelmiştir. Bu 

çalışma, ArcInfo'nun drenaj ağları oluşturma ve çeşitli drenaj havzası fizyografik 

parametrelerinin çıkarılmasındaki kabiliyetini keşfetme çabası sunmaktadır. Jeolojik 

olarak karmaşık bir bölge olan Batı Afganistan’da 150 km
2 

ile 46600 km
2
 arasında 

değişen 11 adet havza bu çalışmada incelenmiştir.  

Bu çalışmada hidroloji ve jeomorfolojide yaygın olarak kullanılan havza 

parametreleri, drenaj yoğunluğu, dere frekansı, akarsu uzunluğu, rölyef oranları, 

sağlamlık sayısı ve eğimler dahil olmak üzere incelenmiştir. Bu çalışmanın amacı, 

küçük ve orta ölçekli havzalar için sayısal yükseklik modeller kullanmanın 
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uygulanabilirliği ile seçilen havzaların fizyografik parametrelerini hidrolojik 

hesaplama ve modellemede değerlendirmektir.  

Akarsu akımları yoksa dijital hat grafiğ (DLG) verilerinin gerçek birinci 

dereceden akımları içermediği kabul edilmektedir. Ancak, DLG’lerde temsil edilen 

bu akarsulara odaklanmak istiyoruz çünkü bunlar iyi tanımlanmış drenaj havzalarına 

ve vadilerine sahip olabilir (Xinhao Wang ve Zhi-Yong Yin,1997). 

2.3 CBS Analizi 

2.3.1 Coğrafi Bilgi Sistemleri 

Hidrolojik analize yönelik CBS yaklaşımları, hidrolojik olarak düzeltilmiş bir 

arazi modeli gerektirir. Hidrolojik olarak düzeltilmiş bir SYM, tüm çöküntülerin 

doldurulduğu bir SYM’dir. CBS, suyun arazi boyunca en büyük yükseklik 

gradyanının yönüne göre hücreden hücreye aktığı 8 noktalı akma modelini 

uygulayarak çöküntüsüz arazi verilerini analiz eder. Analizdeki adımlar, çöküntüleri 

veya çukurları doldurmayı, akım yönünü ve akım toplama hesaplamayı, akımları bir 

birikim eşiğiyle tanımlamayı, akımları tanımlamayı, akımları bölümlere ayırmayı, 

havzaları tanımlamayı, havza poligonlarını işlemeyi, akımları işlemeyi ve havzaları 

birleştirmeyi içerir. 

Devlet kurumları ve veri satıcıları aracılığıyla sağlanan CBS verilerinin 

miktarı yıllar içinde büyük ölçüde artmıştır. Bu verilerin bir kısmı ücretsiz olarak, 

diğerleri ise bir ücret karşılığında sağlanmaktadır. CBS, büyük miktarda veriyi 

yerleştirmek, almak ve analiz etmek için kullanılan bir teknolojidir (Singh ve 

Fiorentino 1996). Buradaki coğrafi bilgi terimi, bir koordinatta tanımlanan arazi 

yüzeylerinin x, y ve z koordinatları anlamına gelir. CBS bir veri işleme aracı 

olduğundan SYM, topografik araştırmalar, arazi kullanımı ve arazi örtüsü haritaları 

gibi bilgileri sağlayan veya kaydeden araçlar CBS ortamında ele alınabilmektedir.  

Bu günlerde, Küresel Konumlandırma Sistemleri (KKS) ve CBS, daha 

eksiksiz bilgi sağlamak için birleştirilmiştir. CBS kullanımı, mekansal, mekansal 

olmayan ve yardımcı verilerin hidrolojik modellerin entegrasyonuna izin verir ve 
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böylece hidrolojik modelleme kapasitesini önemli ölçüde güçlendirir (Mujumdar ve 

Nagesh Kumar, 2012). 

Harita belgesini ayarlamak ve su havzası tanımlama süreci boyunca kullanılacak 

çalışma dizinini oluşturmak için aşağıdaki adımları kullanılabiliriz: 

 Hidroloji araç kutusundaki Doldurma aracı, dijital yükseklik modelindeki 

kusurları (çökmeleri) gidermek için kullanılır. 

 Akım yönü ızgarası, akım yönünü belirtmek için her hücreye bir değer atar 

yani, manzaranın temelindeki topografyaya bağlı olarak suyun o hücreden 

akacağı yönü belirler. 

 Akım toplama aracı, her aşağı eğim hücresine akan yukarı akım hücrelerini 

tanımlayarak her hücreye akımı hesaplar. Başka bir deyişle, her bir hücrenin 

akım toplama değeri, peyzaj topografyasına göre kendisine akan yukarı akım 

hücrelerinin sayısı ile belirlenir. 

 Akma noktası yerleştirme, su havzası tanımlama sürecinde önemli bir 

adımdır. Belirli bir noktaya katkıda bulunan toplam su akımını hesaplamak 

için kullanıldığından yüksek akım toplamanın olduğu bir alanda bir akma 

noktası bulunmalıdır. 

 Dökme noktasını yakalama aracı iki şeyi başarır; yerleştirme sırasındaki 

herhangi bir hatayı hesaba katmak için yaratılan akma noktasını en yakın 

yüksek akımlı hücreye yakalar ve su boşaltma noktasını Watershed aracına 

girdi için raster formatına dönüştürür. 

 Akım yönü veri kümesi ve yakalanmış bir akım noktası hücresi ile bir su 

havzası oluşturabiliriz. 
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Tablo 2.1: Akım gözlem istasyonlarının bilgileri. 

 

 

İstasyon NO İstasyon Adı Akarsu 
Koordinat 

Kot 
(m) 

Alan 
(km

2
) 

Qmaks 
(m

3
/s) 

 

Qort 
(m

3
/s) 
 Doğu Kuzey 

4-0.000-7M Kajaki Rezervuarı Helmand 32.19448611 N 65.07181231 E 
1845 

m+m.s.l 
46600 2155 1060 

4-5.L00-1A Anarjuy Tirin 32.38274442 N 65.34656944 E 
1115 

m+m.s.l 
8055 315 15.3 

4-5.L00-4A Tirin Tirin 32.38274441 N 65.56656944 E 
1358 

m+m.s.l 
3680 325 16.0 

4-000-6M Urosgan Tirin 32.58287778 N 66.39421222 E 
2028 

m+m.s.L 
1060 220 8.20 

4-0.00R-14 Dehraut Helmand 32.42154152 N 65.28106944 E 
1065 

m+m.s.l 
36990 1969 168 

4-1.21.R.5T Yakhdan Kaj 32.58018333 N 65.30323889 E 
1125 

m+m.s.l 
11590 792 42.0 

3-4.L00-7A Gizab Helmand 33.23361389 N 66.17270278 E 
1325 

m+m.s.l 
20750 1304 96.0 

4-13.R00-4A Waras Panjab 34.14047212 N 66.55190133 E 
2480 

m+m.S.l 
1710 175 9.0 

4-14.R00-1A Dahan-i-Reshqa Markhana 34.21263188 N 67.2915861 E 
2580 

m+m.s.l 
1080 83.2 8.43 

4-0.000-10M Gardandiwal Helmand 34.30037511 N 68.1626556 E 
2955 

m+m.s.l 
605 46.7 3.55 

4-16.R00-3A 
Nazdik-i-

Gardandiwal 
Syahsang 34.34216111 N 68.11125556 E 

3010 
m+m.s.l 

160 21.5 1.81 
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2.3.2 Akarsu Akımlarının İstatistikleri 

2.3.2.1 İstasyon Açıklaması 

Bu tezde yer alan her bir akarsu akım gözlem istasyonu ile ilgili konum, 

drenaj alanı, kayıt süresi ve diğer mevcut bilgileri sunulmuştur. Bu bilgiler, 

Afganistan Demokratik Cumhuriyeti Enerji ve Su Bakanlığı tarafından tutulan 

kayıtlardan bilgilerdir. Aşağıdaki yorumlar, istasyonlar ile ilgili çeşitli başlıklar 

altında sunulan bilgileri açıklamaktadır. 

Konum: Gözlem istasyonu konumuyla ilgili bilgiler öncelikle enlem ve 

boylamla sınırlıdır. Mevcut olduğunda, gözlem istasyonunun çevresindeki kültürel 

ve fiziksel özellikler ve gözlem istasyonu adında yer alan topluluk veya yer işareti ile 

ilgili daha fazla bilgi sağlanır. 

Drenaj Alanı: Drenaj alanı ile ilgili Hindistan’nın araştırma haritaları 

kullanılarak ölçülür. 

Yükseklik: Ortalama deniz seviyesi referans alınarak ölçülen referans 

noktasıdır.  

Kayıt Dönemi: Gözlem istasyonu veya eşdeğer bir gözlem istasyonu için 

yayınlanmış kayıtların bulunduğu süredir. Eşdeğer bir gözlem istasyonu söz konusu 

gözlem istasyonundan önce çalışmakta olan ve konumu, ondan gelen kayıtların söz 

konusu gözlem istasyonundan gelen kayıtlarla makul olarak eşdeğer kabul 

edilebileceği şekilde olan bir gözlem istasyonudur. Bu durum, bir gözlem istasyonu 

yukarı veya aşağı yönde yeniden konumlandırıldığında ve yeni bir gözlem istasyonu 

numarası ve adı verildiğinde ortaya çıkar, ancak drenaj alanı ve diğer havza 

özelliklerindeki değişiklikler önemli ölçüde farklılık göstermemektedir. 

Ölçü: Veri toplamak için kullanılan veya kullanılan ölçüm cihazı veya kayıt 

cihaz türüdür. Önceki ölçü aletlerinin tipleri, yerleri ve datalarının yoğunlaştırılmış 

bir geçmişi, mevcut olduğunda bu başlık altında verilmiştir. 
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İstasyonlara ait detaylı bilgiler aşağıda sunulmuştur: 

4-0.000-7M Nolu İstasyon: Helmand Nehri, Kajaki İlçesi Yakınında 

(Devlet Su İşleri Genel Müdürlüğü Jeolojik Araştırma Kimlik Numarası: 

321900065060000) 

Konum: Enlem 32°19’N, Boylam 65°06’E, Kajaki Barajının 1 km doğusunda, 

Kajaki Barajının 2 km aşağısında ve Arghandab Nehrinin 123 km yukarısında yer 

almaktadır. 

Akarsu Havza Alanı: 46600 km
2
. 

Rakım: 1845 metre (ortalama deniz seviyesine göre). 

Kayıt Dönemi: 18 Temmuz 2001’den 30 Nisan 2020’ye kadar. 

Ölçü: Su akımları gözlem ve ölçümleri kaydedici. 

4-5.L00-1A Nolu İstasyon: Tirin Nehri, Anarjuy İlçesi Yakınında 

(Devlet Su İşleri Genel Müdürlüğü Jeolojik Araştırma Kimlik Numarası: 

323800065340000) 

Konum: Enlem 32°38’N, Boylam 65°34’E, Sol kolu olan Dahraman, Helmand 

Nehrinin 6 km yukarısında ve Kajaki Barajının 65 km yukarısında yer almaktadır. 

Akarsu Havza Alanı: 8055 km
2
. 

Rakım: 1115 metre (ortalama deniz seviyesine göre). 

Kayıt Dönemi: 18 Temmuz 2001’den 30 Nisan 2020’ye kadar. 

Ölçü: Su akımları gözlem ve ölçümleri kaydedici. 

4-5.L00-4A Nolu İstasyon: Tirin Nehri, Tirin İlçesi Yakınında 

(Devlet Su İşleri Genel Müdürlüğü Jeolojik Araştırma Kimlik Numarası: 

323800065560000) 

Konum: Enlem 32°38’N, Boylam 65°56’E, arasında yer almaktadır. 

Akarsu Havza Alanı: 3680 km
2
. 
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Rakım: 1358 metre (ortalama deniz seviyesine göre). 

Kayıt Dönemi: 18 Temmuz 2001’den 30 Nisan 30 2020’ye kadar. 

Ölçü: Su akımları gözlem ve ölçümleri kaydedici. 

4-5.L00-8A Nolu İstasyon: Tirin Nehri, Urosgan İli Yakınında 

(Devlet Su İşleri Genel Müdürlüğü Jeolojik Araştırma Kimlik Numarası: 

335800066390000) 

Konum: Enlem 32°58’N, Boylam 66°39’E, arasında yer almaktadır. 

Akarsu Havza Alanı: 1060 km
2
. 

Rakım: 2028 metre (ortalama deniz seviyesine göre). 

Kayıt Dönemi: 18 Temmuz 2001’den 30 Nisan 2020’ye kadar. 

Ölçü: Su akımları gözlem ve ölçümleri kaydedici. 

4-0.000-8M Nolu İstasyon: Helmand Nehri, Dehraut İilçesi Yakınında 

(Devlet Su işleri Genel Müdürlüğü Jeolojik Araştırma Kimlik Numarası: 

324200065280000) 

Konum: Enlem 32°42’N, Boylam 65°28’E, Sağ tarafta Dehraut ilçesinin 10 km 

yukarısında, Tirin Nehrinin 15 km yukarısında, Kajaki Barajının 70 km yukarısında, 

ve Kandahar ilinin 120 km kuzeyinde yer almaktadır. 

Akarsu Havza Alanı: 36990 km
2
. 

Rakım: 1065 metre (ortalama deniz seviyesine göre). 

Kayıt Dönemi: 18 Temmuz 2001’den 30 Nisan 2020’ye kadar. 

Ölçü: Su akımları gözlem ve ölçümleri kaydedici. 
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4-6.R00-1A Nolu İstasyon: Kaj Nehri, Ghor İli Yakınında 

(Devlet Su İşleri Genel Müdürlüğü Jeolojik Araştırma Kimlik Numarası: 

32580006530000) 

Konum: Enlem 32°58’N, Boylam 65° 30’E, arasında yer almaktadır. 

Akarsu Havza Alanı: 11590 km
2
. 

Rakım: 1125 metre (ortalama deniz seviyesine göre). 

Kayıt Dönemi: 18 Temmuz 2001’den 30 Nisan 2020. 

Ölçü: Su akımları gözlem ve ölçümleri kaydedici. 

4-0.000-9 1A Nolu İstasyon: Helmand Nehri, Gizab İlçesi Yakınında 

(Devlet Su İşleri Genel Müdürlüğü Jeolojik Araştırma Kimlik Numarası: 

332300066170000) 

Konum: Enlem 33°23’N, Boylam 66°17’E, arasında yer almaktadır. 

Akarsu Havza Alanı: 20750 km
2
. 

Rakım: 1325 metre (ortalama deniz seviyesine göre). 

Kayıt Dönemi: 18 Temmuz 2001’den 30 Nisan 2020’ye kadar. 

Ölçü: Su akımları gözlem ve ölçümleri kaydedici. 

4-13.R00-4A Nolu İstasyon: Punjab Nehri, Waras İlçesi Yakınında 

(Devlet Su İşleri Genel Müdürlüğü Jeolojik Araştırma Kimlik Numarası: 

341400066550000) 

Konum: Enlem 34°14’N, Boylam 66°55’E, arasında yer almaktadır. 

Akarsu Havza Alanı: 1710 km
2
. 

Rakım: 2480 metre ortalama deniz seviyesine göre. 

Kayıt Dönemi: 18 Temmuz 2001’den 30 Nisan 2020’ye kadar. 

Ölçü: Su akımları gözlem ve ölçümleri kaydedici. 
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4-14.R00-1A Nolu İstasyon: Markhana Nehri, Dahane Rishqa İlçesi Yakınında 

(Devlet Su İşleri Genel Müdürlüğü Jeolojik Araştırma Kimlik Numarası: 

34210006729000) 

Konum: Enlem 34°21’N, Boylam 67°29’E, arasında yer almaktadır. 

Akarsu Havza Alanı: 1080 km
2
. 

Rakım: 2580 metre (ortalama deniz seviyesine göre). 

Kayıt Dönemi: 18 Temmuz 2001’den 30 Nisan 2020’ye kadar. 

Ölçü: Su akımları gözlem ve ölçümleri kaydedici. 

3-0.000-7M Nolu İstasyon: Helmand Nehri, Gardandewal İlçesi Yakınında 

(Devlet Su İşleri Genel Müdürlüğü Jeolojik Araştırma Kimlik Numarası: 

343000068160000) 

KONUM: Enlem 34°30’N, Boylam 68°16’E, arasında yer almaktadır. 

Akarsu Havza Alanı: 605 km
2
. 

Rakım: 2955 metre (ortalama deniz seviyesine göre). 

Kayıt Dönemi: 18 Temmuz 2001’den 30 Nisan 2020ye kadar. 

Ölçü: Su akımları gözlem ve ölçümleri kaydedici. 

4-16.R00-3A Nolu İstasyon: Syahsang Nehri, Gardandewal İlçesi Yakınında 

(Devlet Su İşleri Genel Müdürlüğü Jeolojik Araştırma Kimlik Numarası: 

343400068110000) 

Konum: Enlem 34°34’N, Boylam 68°11’E, arasında yer almaktadır. 

Akarsu Havza Alanı: 160 km
2
. 

Rakım: 3010 metre (ortalama deniz seviyesine göre). 

Kayıt Dönemi: 18 Temmuz 2001’den 30 Nisan 2020’ye kadar. 

Ölçü: Su akımları gözlem ve ölçümleri kaydedici. 
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2.3.3 Sayısal Yükseklik Modelinin Hazırlanması 

Bir SYM, sürekli bir yüzeyin raster gösterimidir. Genellikle X, Y ve Z 

değerleri bilinen ve rastgele bir koordinat sisteminde tanımlanan bir dizi nokta 

kullanarak dünyanın yüzeyini ifade eder. Sayısal yükseklik modellerinden 

türetilebilen bilgilerin yanı sıra hidroloji, risk analizi, şehir planlama gibi farklı 

alanlarda uygulanabilir. Bir SYM’den elde edilebilecek ana ürünlere (eğim haritaları, 

konturlar, kabartma haritaları, görünürlük haritaları, yön haritaları, su havzaları, 

görüş alanı vb.) ulaşılabilir. 

SYM’ler tipik olarak Amerika Birleşik Devletleri Jeoloji Araştırmaları 

Kurumu (USGS) haritalarından oluşturulur ve birden fazla çözünürlük için 

kullanılabilir. Sayısal yükseklik model verileri USGS Ulusal Yükseklik Veri Kümesi 

(NED) programından toplanabilir. Genellikle araziyi modellemek için 30*30 metre 

çözünürlükte sayısal yükseklik modelleri yaygın olarak kullanılabilir (USACE, 

2009). 

 

Şekil 2.4: Sayısal yükseklik modeli. 

Arazi verilerini girdi olarak kullanan arazi ön işlemesi, drenaj ağını 

oluşturmak için bir dizi işlemler olarak tanımlanmaktadır. Tanımlanan işlemler, akım 
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yönünün, akım toplamanın, akım tanımının ve su havzasının tanımlanmasından 

oluşmaktadır. Bu işlemler adım adım veya toplu olarak yapılabilir. Bu veri kümeleri 

geliştirildikten sonra, alt havza ve su akım tanımlamak için sonraki işlemlerde 

kullanılırlar. Arazi ön işleme aşamalarının, su havzası ve akarsu akımı tanımalama, 

drenaj ağını belirleme ve ön hazırlık olduğunu bilmek gerekmektedir. Bir sonraki 

işlemde havuz işlemede kullanıcı havuzları proje özelliklerine göre betimleme ve 

düzenleme yeteneğine sahiptir. Bu çalışmada arazi ön işlemesi, CBS ortamında 

Hydro Tools tarafından yapılan havza tanımlama işlemi aşağıda verilmiştir. Arc 

Hydro araç çubuğu, geniş bir kullanım alanı için tasarlanmıştır. 

Arazi ön işleme analizi için ilişkin ana adımlar aşağıdaki gibidir: 

 DEM Manipulations (SYM Manipülasyonları) → Fill sinks (Boşlukların 

doldurulması) 

 Flow direction (Akım yönü) 

 Flow accumulation (Akım toplama) 

 Stream definition (Akım tanımı) 

 Stream segmentation (Akım segmentasyonu) 

 Catchment grid delineation (Havza ızgara tanımlaması) 

 Catchment polygon processing (Havza poligon işleme) 

 Drainage line processing (Drenaj hattı işleme) 

 Adjoint catchment processing (Ortak havza işleme) 

 Drainage point processing (Drenaj noktası işleme) 

 Use pore point (Create Batch Point at the outlet of the catchment).[(Gözenek 

noktası kullanın (Havzanın çıkışında Toplanma Noktası Oluşturun)]. 

 Watershed Processing (Havza İşleme) 

 Batch watershed delineation (Toplanma havzası tanımlama) 

 Flow path tracing- select this tool and then click on the end of each drainage 

line. (Akım yolu izleme, bu aracı seçin ve ardından her bir drenaj hattının 

sonuna tıklayın.) 

 Terrain preprocessing (Arazi ön işleme) 

 Slope (Eğim) 

 



21 

 

 Characteristic (Karakteristik) 

 River length (Nehir uzunluğu) 

 River slope (Nehir eğimi) 

 Basin slope (Input RawDem in ‘Input slope grid’) (Havza eğimi (“Girdi 

eğimi ızgarasında” Giriş Raw DEM)) 

 Longest Flow Path (En uzun akım yolu) 

 Basin Centroid (Havza ağırlık merkezi) 

 Centroid Elevation (Centroid yükselti) 

 Centroid Longest Flow Path (Centroid en uzun akım yolu) 

2.3.4 Çukursuz SYM Oluşturulması 

ArcToolbox > Fill (Spatial Analyst Tools) komutu ile verilerdeki tüm 

kusurları gidermek için bir yüzey taramasında havuzları doldurur.  

Hidroloji araç kutusundaki doldurma aracı, sayısal yükseklik modelindeki 

kusurları (çukurları) gidermek için kullanılır. Bir çukur, ilişkili bir drenaj değerine 

sahip olmayan bir hücredir. Drenaj değerleri suyun hücreden dışarı akacağı yönü 

gösterir ve peyzaj için bir akım yönü ızgarası oluşturma işlemi sırasında atanır ve 

ortaya çıkan drenaj ağını bulmaya yarar. 

 

Şekil 2.5: Arc Toolbox’ta fill komutu. 
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2.3.5 Akım Yönü 

ArcToolbox > Flow Direction (Spatial Analyst Tools) komutu, her hücreden 

aşağı eğimli komşu hücreye veya komşu hücrelerine doğru bir akım yönü çizgisi 

oluşturmaktadır. 

Akım yönü ızgarası, akım yönünü belirtmek için her hücreye bir değer 

ekleyerek arazinin temelindeki topografyaya bağlı olarak suyun o hücreden akacağı 

yönü göstermektedir. Bu hidrolojik modellemede çok önemli bir adımdır, çünkü 

akım yönünü ve kara yüzeyinden akan suyun son hedefini belirleyecektir. 

 

Şekil 2.6: ArcToolbox’da akım yönünün belirlenmesi. 

2.3.6 Akım Toplama 

ArcToolbox > Flow Accumulation (Spatial Analyst Tools) komutu ile her 

hücreye birikmiş akarsu akımı oluşturulur. İsteğe bağlı olarak bir ağırlık faktörü 

uygulanabilir. 

 Akım toplama aracı, çıktı rasterdeki her aşağı eğim hücresine akan suyun tüm 

hücrelerin toplanmış ağırlığı olarak toplanmış akımı hesaplar. Ağırlık raster 

sağlanmadıysa, her hücreye 1 ağırlık uygulanır ve çıktı rasterdeki hücrelerin 

değeri her hücreye akan hücrelerin sayısıdır. 
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 Akım toplama aracı, her aşağı eğim hücresine akan yukarı akım hücrelerini 

tanımlayarak her hücreye akımı hesaplar. Diğer bir deyişle, her bir hücrenin 

akım toplama değeri, peyzaj topografyasına dayalı olarak kendisine akan 

yukarı akım hücrelerinin sayısı ile belirlenir. 

 Izgaradaki her hücre, o belirli hücreden yukarı akımdaki hücrelerin sayısını 

temsil eden bir değer içerir. Daha yüksek akım toplama değerlerine sahip 

hücreler, suyun aktığı vadiler veya drenaj kanalları gibi daha düşük kotlu 

alanlarda konumlandırılmalıdır. 

 Akım toplamanın sonucu, her aşağı eğim hücresine akan tüm hücrelerin 

ağırlığının toplanmasıyla belirlendiği üzere, her hücreye toplanmış akımın bir 

rasteridir. 

 Yüksek akım toplamına sahip çıkış hücreleri, toplanma akım alanlarıdır ve 

akım kanallarını tanımlamak için kullanılabilir. 

 Sıfır akım toplamına sahip çıktı hücreleri, yerel topografik zirvelerdir ve 

sırtları tanımlamak için kullanılabilir. 

 

Şekil 2.7: Akım toplamanın belirlenmesi. 
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2.3.7 Havza Çıkış Noktası 

Bu aşamada Catalog komutu kullanılarak nokta vektör formatında bir 

shapefile dosyası oluşturulur. Bir havza bölümünden gelen yüzeysel suların 

toplanarak havzayı terk ettiği akarsu kesitine, suyun bir alandan dışarı aktığı 

yüzeydeki çıkış noktası veya su havzasının sınırı boyunca en alçak noktasına 

havzanın çıkış noktası denilir. 

Akım toplama önemlidir, çünkü akımların ve kanalların beklendiği yerlerde 

yüksek akımlı hücreleri bulmamıza izin verir. Her hücrenin, suyun hücreden doğal 

olarak akacağı yeri gösteren akma noktası adı verilen bir çıkış noktası vardır. Akarsu 

akımı toplama noktaları, yüksek kümülatif akıma sahip hücrelerde bulunmalıdır, aksi 

takdirde belirtilen su havzaları çok küçük alanları kapsayacaktır. 

Bu aşamada tez kapsamında incelenen Helmand Bölgesi üzerinde bulunan 11 

adet alt havzadan 4-0.000-10M nolu havzanın sınırlarından yararlanarak havzanın 

sayısal yükseklik modeli, akım yönü, akım toplama tabakalarından çıkartılarak elde 

edilen tabakalar sırasıyla aşağıdaki şekillerde gösterilmektedir. Geri kalan 10 adet 

havza ekte gösterilmiştir. 

Akma noktası yerleştirme, su havzası tanımlama sürecinde önemli bir 

adımdır. Belirli bir noktaya katkıda bulunan toplam su akımını hesaplamak için 

kullanıldığından, yüksek akım birikiminin olduğu bir alanda bir akma noktası 

bulunmalıdır. Çoğu durumda, örnekleme sahaları, hidrometrik istasyonlar veya başka 

bir veri kaynağı olsun, akma noktalarımızın konumlarını içeren bir dosyamız zaten 

olacaktır. Ancak bazı durumlarda, akma noktalarının manuel olarak oluşturulması 

gerekli olabilir veya tercih edilebilir. 
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Şekil 2.8: Havza çıkış noktası belirlenmesi. 

2.3.8 Havza Çıkış Noktasının Raster Formatına Dönüştürülmesi 

ArcToolbox > Snap Pour Point (Spatial Analyst Tools) komutu ile havzanın 

çıkış noktası raster formatına dönüştürür. 

Akma noktasını yakalama aracı iki şeyi başarır; yerleştirme sırasındaki 

herhangi bir hatayı hesaba katmak için yaratılan akma noktasını / noktalarını en 

yakın yüksek akımlı hücreye bağlar ve su boşaltma noktalarını havza aracına girdi 

için raster formatına dönüştürür. 
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Şekil 2.9: Havza çıkış noktasının raster formatına dönüştürülmesi. 

2.3.9 Havza Sınırlandırılması 

ArcToolbox > Watershed (Spatial Analyst Tools) komutu ile iki komşu 

havzayı ayıran çizgi havza sınırı veya su ayrım çizgisi olarak adlandırılır. Bu adım, 

her akım birleştiğinde yukarı havza alt havzalarını toplar. Bu gerekli bir adımdır ve 

havza modelleme için gerçekleştirilir.  

Su havzası, yoğun drenaj olarak ortak bir çıkışta su akımına katkıda bulunan 

yukarı eğimli alandır. Daha büyük bir havzanın parçası olabilir ve ayrıca alt havzalar 

adı verilen daha küçük havzalar da içerebilir. Su havzaları arasındaki sınırlar, drenaj 

bölmeleri olarak adlandırılır. Çıkış veya akma noktası, suyun bir alandan dışarı aktığı 

yüzeydeki su havzasının sınırı boyunca en alçak noktadır. 

2.3.10 Havzaları Tanımlama 

 Akarsuyun sularını toplayan alana akarsu havzası (drenaj alanı, su toplama 

havzası, yağış alanı) denir.  

 Havzalar, akım yönü belirtilerek ve bu havza aracında kullanılarak bir 

SYM’den tanımlanabilir. 
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 Katkıda bulunan alanı belirlemek için, önce akım yönü aracıyla akım yönünü 

temsil eden bir raster oluşturulmalıdır. Daha sonra, havza alanını belirlemek 

için istediğiniz yerleri sağlamanız gerekecektir. 

 Kaynak konumları, katkıda bulunan alanın özelliklerini belirlemek 

istediğimiz, barajlar veya dere göstergeleri gibi özellikler olabilir. Eğimli bir 

havzayı tanımlamak için kullanıldığında, havza için akma noktaları, akım 

birikiminden türetilen bir akarsu ağının bağlantıları olacaktır. Bu nedenle, bir 

akımı oluşturan minimum hücre sayısının (eğim değeri) yanı sıra bir akım 

toplamı rasterde belirtilmelidir. 

 Her havzanın değeri, girdi raster veya havza özellikleri akma noktası 

verilerindeki kaynağın değerinden alınacaktır. Akma noktası bir tarama veri 

kümesi olduğunda, hücre değerleri kullanılacaktır. Ayrıca akma noktası bir 

nokta özelliği veri kümesi olduğunda, değerler belirtilen alandan gelecektir. 

 

Şekil 2.10: Havzanın sınırlandırılması. 

2.4 Havza Fizyografik Parametreleri 

Su havzalarının biçim ve süreçlerini değerlendirmek için drenaj morfometrik 

parametrelerinin değerlendirilmesinde SRTM-DEM ve CBS Hydro Tools yaklaşımı 

ve bunların hidrolojik özellikler üzerindeki etkileri, geleneksel yöntemlere göre daha 

uygundur (Sreedevi ve ark., 2013).  
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CBS ile Hydro Tools, su havzası hidrolojik ve hidrolik modelleme için bir 

CBS ortamında etkili bir şekilde kullanılabilir (Patel, 2009). 

Bu çalışmada, CBS Hydro Tools ve uzaktan algılama (UA) kombinasyonu, 

Afganistan’ın Helmand Nehir Bölgesinin analizinde kullanılmıştır. Ön işleme için 

ana giriş verisi olarak yaklaşık 30*30 m yatay çözünürlüklü SYM kullanılmıştır. 

CBS’deki Hydro Tools, temel olarak arazi ön işleme, arazi morfolojisi, havza 

işleme, nitelik araçları ve ağ araçlarından oluşur. SYM’den gelen su havzası 

tanımlama işlemlerinin çoğu arazi ön işleme ile yapılabilir. CBS ortamında arazi ön 

işlemesi için ana adımlardan bazıları Şekil 2.11’de gösterilmektedir. 

 

Şekil 2.11: CBS’de arazi ön işlemesi için ana adımlar. 

Arc Hydro Tools uzantılarını kullanarak, istenen su havzasını tanımlamak 

çok pratiktir. CBS, su kaynakları yönetim ve planlanma çalışmalarında, su kaynakları 

alanında karşılaşılan problemleri noktasal ve lokal boyuttan çıkarıp bölgesel ölçeğe 

dönüştürür. SYM, su havzası tanımlaması için bir ana girdi verisi olarak 

kullanılabilir. Akarsu ağları, arazi ön işlemesi ile oluşturulmaktadır. 

Boşlukların Doldurulması 

Sayısal Yükseklik Modeli 

Akım Yönü 

Akım Toplama 

Akım Tanımı 

Akım Segmentasyonu 

Havza Izgara Tanımlaması 

Havza Poligon İşleme 

Drenaj Hattı İşleme 

Ortak Havza İşleme 
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CBS, su havzası tanımlaması için güçlü bir araç olarak kullanılabilir. CBS 

yardımıyla havza fizyografik parametrelerinin analizi, havzanın hidrolojik 

davranışını karakterize etmek için uygun bir yöntem olarak ortaya çıkmaktadır. 

Analiz SYM ile yapılabilir. SYM Amerika Birleşik Devletleri Jeoloji Servisi (USGS) 

web sitesinden ediilebilir (USGS, 2004). 

 

Şekil 2.12: Girdiler ve çıktılar için ön işlem şeması (Agrawal, 2005). 

2.4.1 Havzanın Poligona Çevrilmesi 

ArcToolbox > Conversion Tools > From Raster > Raster To Polygon komut 

dizisi ile bir raster veri kümesi çokgen unsurlarına dönüştürülür. 

Raster, ArcGIS Raster to Polygon aracı kullanılarak bir çokgen özellik 

sınıfına dönüştürülecektir. Bu araç yalnızca tam sayı rasterleri çokgenlere 

dönüştürebilir. Eğer girdi raster bir kayan noktalı raster ise, onu bir tamsayı rasterine 

dönüştürmek için Map Algebra Expression parametresini kullanmamız gerekir. 
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Girdi taraması herhangi bir hücre boyutuna sahip olabilir; bunun için geçerli 

bir tamsayı tarama veri kümesi olmalıdır. Alan parametresi, girdi tarama veri 

kümesinin hangi öznitelik alanının çıktı özelliği sınıfında bir öznitelik haline 

geleceğini seçmemize olanak tanır. Bir alan belirtilmezse, giriş rasterinin (değer 

alanı) hücre değerleri, çıkış özelliği sınıfının öznitelik tablosundaki Kılavuz kodu 

başlığına sahip bir sütun haline gelecektir 

 

Şekil 2.13: Havzanın poligona çevrilmesi. 

2.4.2 Tüm SYM’den İlgilenilen Havzanın Çıkarılması 

ArcToolbox > Spatial Analyst Tools > Extraction > Extract by Mask komut 

dizisi ile tanımlanan alanlara karşılık gelen bir rasterin hücreleri ayıklanır. 

Uzantısı çıktı rasterinin kapsamını sınırlayan bir şablon olarak başka bir 

katmanı (raster veya varlık) kullanarak bir rasterin belirli bir alanını seçmek 

mümkündür. Varsa, girdi taramasından gelen ek öznitelikler çıktı tarama öznitelik 

tablosuna olduğu gibi taşınacaktır. Çıktı raster, kabul ettirmek ettiğimiz uzantıya 

bağlı olarak öznitelik tablosunu koruyacaktır. Sayısal yükseklik modelinden 4-0.000-

10M nolu havzanın sınırlarından yararlanarak havzanın sayısal yükseklik modeli, 

akım yönü, akım toplama tabakalarından çıkartılarak elde edilen tabakalar sırasıyla 

aşağıdaki şekillerde gösterilmektedir. 
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Şekil 2.14: 4-0.000-10M nolu havzanın sayısal yükseklik modeli haritası. 

 

Şekil 2.15: 4-0.000-10M nolu havzanın akım yönü haritası. 
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Şekil 2.16: 4-0.000-10M nolu havzanın akım toplama haritası. 

2.4.3 Havza Alanının Hesabı 

Farklı varlıkların alanını, çevresini veya uzunluğunu hesaplamak için her 

katmanın geometrisini hesaba katmak gerekir. Geometri hesapla komutu ile seçilen 

havzanın, alan, çevre ve uzunluk alanlarındaki değişiklikler otomatik olarak 

güncellenmez. Her değişiklikten sonra mevcut değerleri yeniden Geometri hesapla 

komutu çalıştırarak hesaplamak gerekir. 

Özellikler tablosunda, Tablo Seçeneklerinde > Alan Ekle seçeneğiyle alan 

sütün eklenir. Alan sütün üst kısmı sağ tıklanarak ve geometriyi hesapla seçilir. 

Geometriyi hesapla iletişim kutusundan, özellikler açılır menüsünden alan seçilir. 

Tamam tıklandığında havzanın alan değerleri otomatik olarak hesaplanır. 
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Şekil 2.17: Havza alanının hesaplanması. 

 

Şekil 2.18: Poligon formatındaki havza alanının hesap adımları. 
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2.4.4 Havza Çevresinin Hesabı 

Farklı varlıkların alanını, çevresini veya uzunluğunu hesaplamak için her 

katmanın geometrisini hesaba katmak gerekir. 

Özellikler tablosunda, Tablo Seçeneklerinde > Alan Ekle seçeneğiyle çevre 

sütünu eklenir. Çevre sütün üst kısmı sağ tıklanır ve geometri hesapla seçilir 

Geometriyi hesapla iletişim kutusundan, Özellikler açılır menüsünden çevre seçilir. 

Tamam tıklandığında havzanın çevre değerleri otomatik olarak hesaplanır. 

 

Şekil 2.19: Poligon formatındaki havza çevresinin hesap adımları. 
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2.4.5 Havzanın Ağırlık Merkezinin Bulunması 

Bu yöntem, ağırlık merkezlerinin enlemini (merkezin Y koordinatı) ve 

boylamını (X koordinatı) bulmak için geometri hesapla işlevini kullanır ve bunları 

görüntülemek için bir X, Y olay katmanı oluşturur. 

Farklı varlıkların alanını, çevresini veya uzunluğunu hesaplamak için her 

katmanın geometrisini hesaba katmak gerekir.  

 Özellikler tablosunda, tablo seçeneklerinde > alan ekle seçeneği ile Gx ve Gy 

olmak üzere iki yeni sütün eklenir biri Boylam ve diğeri Enlem olarak 

adlandırılır. 

 Boylam alanına sağ tıklayarak ve calculate geometriyi hesapla seçeneği 

seçilir. 

 Geometriyi hesapla iletişim kutusunda, özellikler açılır menüsünden X 

koordinat merkezini seçilir tamamı tıkladığınızda X koordinat otomatik 

olarak hesaplanır. 

 Enlem alanına sağ tıklayıp geometriyi hesapla seçilir. 

 Geometriyi hesapla iletişim kutusunda, özellik açılır menüsünden Y 

koordinat merkezi seçilir, Tamam tıklanır ve Y koordinatı otomatik olarak 

hesaplanır. 
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Şekil 2.20: Havza çıkış noktası ve ağırlık merkezinin koordinatlarının bulunması. 

2.4.6 Eğim 

ArcToolbox > Spatial Analyst Tools > Surface > Slope komut dizisi ile 

tanımlanan alanlarda eğim haritaları oluşturulur. 

Eğim, bir havzanın en yüksek ve en alçak noktalarını belirleyen ve 

farklılaştıran ana faktördür. Farklı yüksekliklere sahip iki nokta verildiğinde, arazinin 

eğiminin, yükseklik farkı ile yükseklik farkı arasındaki orantılı ilişki tarafından 

belirlenen matematiksel oran olduğu anlaşılır. 

Eğim, yüzde veya altmışlık dereceler olarak ifade edilebilir. Bir eğim raster 

oluşturmak için, girdi bilgisi olarak bir SYM gereklidir ve Slope aracı konumda 

bulunan eğim rasterini oluşturmak için kullanılır. Havzanın eğimi, farklı dirence 

sahip havza alanının kaya türüne bağlıdır. Eğim unsurları, suyun akımıyla büyük 

ölçüde ilişkilidir bu nedenle yağmur suyunun nehir havzasının ağını oluşturan nehir 

yataklarına girmesi için gereken süreyi etkiler. 
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2.4.6.1 Eğim Haritası 

Eğim, uzaklığa göre yüzey değerindeki değişimin ölçüsüdür; derece veya 

yüzde olarak ifade edilebilir. Bir raster formatında, Sayısal Yükseklik Modeli 

(SYM), her hücrenin ortak bir veriye referans verilen bir değer olduğu bir ızgaradır. 

Uzaktan algılamada yükseklik çıkarımı için özel yazılım paketleri gereklidir ancak 

çoğu GIS paketinin nokta veya kontur çizgisi interpolasyonu için rutinleri vardır. 

Izgara üzerindeki herhangi iki nokta ile bir eğimi tespit etmek yeterli olacaktır. 

Eğimler hesaplandıktan sonra, maksimum fark bulunabilir ve eğim belirlenebilir 

(Burrough ve McDonnell, 1998, Maathuis, 2006, Jha ve diğerleri, 2007). 

Bu çalışmada havza alanı için topografik yükseklik haritası, Mekik Radar 

Topografya Görevi (SRTM) verilerinden çıkarılan SYM ile geliştirilmiştir. Bunun 

için SYM, iki yönlü gradyan filtresine (biri x yönünde diğeri y yönünde) tabi tutuldu. 

Ortaya çıkan haritalar, ArcGIS Spatial Analyst araçları kullanılarak çalışma alanının 

bir eğim haritasını oluşturmak için kullanılır. 

En yüksek topografik yükseltiler (5064 m ve en düşük 964 m AMSL), en 

yüksek yüzey akımına ve dolayısıyla daha az yağış sızması olasılığına neden olan 

bölgenin batı ve kuzeybatı kısımlarında mevcuttur. Çalışma alanının eğim haritası 

derece olarak beş sınıfa ayrılmıştır. 1–3° (Yumuşak), 3–5° (Orta), 5–10° (Dik), 10–

35° (Çok Dik) ve > 35° (Çok Çok Dik) (Şekil 2.21).  

Bir raster hücresinin eğim değeri 3*3’lük hücre penceresinin batı-doğu ve 

kuzey-güney yönündeki kot farkı değerleri ile hesaplanmıştır. Batı-doğu eğimi (G) 

ve kuzey-güney eğimi (H) ile Şekil 2.21’de 3*3’lük hücre penceresinden kotu Z5 

olan 5 numaralı hücre eğimi hesaplanmıştır. Daha büyük pencere boyutları, arazi 

yüzey süreçlerini uygun bir ölçekte yakalamak için yüksek çözünürlüklü yükseklik 

verileriyle kullanılmaktadır. Yüzey parametreleri ayrıca arazinin yerel değişkenliğini 

değerlendiren ve her hücre için en uygun komşuluk boyutunu tanımlayan 

uyarlanabilir bir pencere seçeneği sunar. Batı-doğu eğimi (G) ve kuzey-güney eğimi 

(H) Denklem 2.1 ve Denklem 2.2’de gösterilmektedir. 
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Şekil 2.21: Eğim haritası. 

(2.1) 

H =
[(𝑍1 + 2𝑍2 + 𝑍3) − (𝑍7 + (𝑍1 + 2𝑍8 + 𝑍9)]

8∆𝑦
 (2.2) 

Denklem 2.1 ve Denklem 2.2’de Z hücre yüksekliği, Δx hücre genişliği, Δy hücre 

yüksekliğini göstermektedir.  

Denklem 2.3’te gösterildiği gibi, eğim derece cinsinden hesaplanmaktadır. 

Eğim =
π√G2 + H2

180
 (2.3) 

Hücre eğimlerinin hesaplanması havzanın doldurulmuş (fill) SYM’si kullanılmıştır 

Şekil 2.23’te göstermektedir. 

ArcToolbox > Spatial Analyst Tools > Surface > Slope komutları ile eğim 

hesaplanmıştır. 

 

G =
[(𝑍3 + 2𝑍3 + 𝑍9) − (𝑍3 + (𝑍1 + 2𝑍4 + 𝑍7)]

8∆𝑥
 



39 

 

 

Şekil 2.22: Hücre eğimlerinin hesaplanması. 

2.4.7 Bakı 

Arc Toolbox > Spatial Analyst Tools > Surface Analyst > Aspect komut 

dizisi ile havzanın bakı değerleri tanımlanır. 

Yeniden sınıflandırma aracı, bir raster değerinin yeniden sınıflandırılmasına 

olanak tanır. Yani her bir hücrenin mevcut değerlerini yeni bilgilerle değiştirir. 

Veriler, içinde depolanan herhangi bir değişkeni yeniden sınıflandırabilir. 

𝑌ö𝑛 = 2tan−1
−𝐺

√𝐻2 + 𝐺2 + 𝐻
(
180

𝜋
) (2.4) 

EĞER Yön > 90° İSE Bakı = (450-Yön) DEĞİLSE Bakı = (90-Yön) (Şekil 2.23) 

göstermektedir 
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Şekil 2.23: Bakı. 

Bakı değerlerine göre hücre yönleri Tablo 2.2’de verilmiştir. ArcGIS’te 

Kuzey yönü 0 derece olarak kabul edilerek bakı açısı (derece) saat yönünde 

artmaktadır.  

Tablo 2.2: Bakı değerlerine göre hücre yönleri. 

Bakı Açısı (Derece) Yön Kısaltma 

-1 Düz BAKI_DÜZ 

338-22 Kuzey BAKI_K 

23-67 Kuzeydoğu BAKI_KD 

68-112 Doğu BAKI_D 

113-157 Güneydoğu BAKI_GD 

158-202 Güney BAKI_G 

203-247 Güneybatı BAKI_GB 

248-292 Batı BAKI_B 

293-337 Kuzeybatı BAKI_KB 
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2.4.8 Ortalama Yükseklik, Maksimum Yükseklik, Minimum Yükseklik, 

Kot-Rölyef Oranı 

Kot-Rölyef oranı (E), SYM raster tabakaları ortalama yükseklik ile minimum 

yükseklik arasındaki farkının raster tabakalarının maksimum yükseklik ile minimum 

yükseklik arasındaki farkının oranıdır. Her havzanın Kot-Rölyef oranını hesaplamak 

için aşağıdaki 2.5 denkleminden yararlanabiliriz. 

𝐸 =
(Ortalama kot − Minimum kot)

(Maksimum kot − Minimum kot)
 (2.5) 

Sayısal yükseklik modelinden raster tabakalarının minimum, maksimum (H_MAK), 

ortalama (H_ORT) ve standart sapma değerleri ArcGIS’te sayısal yükseklik 

modelinin Properties penceresinden Şekil 2.24’te gösterildiği gibi hesaplanmaktadır. 
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Şekil 2.24: Ortalama, maksimum, minimum, kot-rölyef oranı. 

2.4.9 Bölgesel İstatistikler 

ArcToolbox > Spatial Analyst Tools > Math > Int komutu ile mevcut 

istatistikler tanımlanır. 

Bölgesel istatistik eklentisi ile raster tabakalardaki hücrelerin değerleri ve 

elde edilen değerlere sahip hücre sayıları hesaplanmıştır. Poligonal bir vektör 

katmanı yardımıyla bir raster katmanının dijital görüntülerinin birkaç değerini 

hesaplamanıza olanak tanır. Bölgesel istatistikleri tanımlamak için bir renk bandı 

seçerek vektör katmanında kullanıcı bir örnek ile çıktı sütunları oluşturur ve her 

çokgen için, içindeki dijital görüntüler ile ilgili istatistikleri hesaplar. 

 Mevcut istatistikler: 

 Say: Dijital görüntülerin sayısını saymak için tanımlanır. 

 Topla: Dijital görüntülerin değerlerini toplamak için tanımlanır. 

 Ortalama: Dijital görüntülerin değerlerinin ortalamasını elde etmek için 

tanımlanır. 

 Medyan: Dijital görüntülerin değerlerinin medyanını almak için tanımlanır. 
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 Standart sapma: Dijital görüntülerin değerlerinin standart sapmasını elde 

etmek için tanımlanır. 

 Minimum: Minimum dijital görüntülerin değerlerini elde etmek için 

tanımlanır. 

 Maksimum: Maksimum dijital görüntülerin değerlerini elde etmek için 

tanımlanır. 

 Aralık: Dijital görüntülerin değer aralığını (Maks-Min) elde etmek için 

tanımlanır. 

 Azınlık: Daha az temsil edilen dijital görüntülerin değerini elde etmek için 

tanımlanır. 

 Çoğunluk: En çok temsil edilen dijital görüntülerin değerini elde etmek için 

tanımlanır. 

 Çeşitlilik: Farklı dijital görüntülerin değerlerinin sayısını saymak için 

tanımlanır. 

 

Şekil 2.25: Bölgesel istatistikler. 

 

 

 



44 

 

2.4.10 Akarsu Çatallanma Oranı (Stream Order) 

ArcGIS’in ArcToolbox > Spatial Analyses Tools > Hydrology > Stream 

Order komutu ile akarsu çatallanma oranı Strahler (STR) ve Shreve’e (SHR) göre 

belirlenmiştir. 

Akarsu düzen sistemleri, bir nehir sisteminin sistematik haritalanması için de 

önemlidir ve akarsuların net bir şekilde etiketlenmesini ve sıralanmasını sağlar. Bu 

çalışmada havzanın çatallanma oranı Strahler (STR) ve Shreve’e (SHR) göre 

belirlenmiştir (Şekil 2.26). 

 

Şekil 2.26: ArcGIS’te çatallanma oranının belirlenmesi. 

2.4.11 Akım Sırası (Nu) 

Drenaj havza analizi için dere sıralaması önemli bir husustur. Akarsu akım 

toplama noktası akarsuyun konumunun bir ölçüsü olarak tanımlanır (Horton 1945; 

Strahler 1957; Leopold ve diğerleri 1964). Strahler (1964), akarsuların sıralanması 

için bir yöntem önermiştir. En küçük parmak ucu kolları 1 sıra olarak belirlenmiştir. 
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Akım sıralaması, bir akım ağındaki bağlantıları sayısal bir sıra ile atama 

yöntemidir. Bu sıralama, akarsu türlerini yan kolları sayılarına göre tanımlama ve 

sınıflandırma yöntemdir. Akımların bazı özellikleri, sadece akım sıralarını bilerek 

çıkarılabilir. Akım sırası, dere, yüzey akımı, drenaj alan boyutu hakkında bilgi verir 

ve kapsamı doğrudan su havzasının boyutuyla orantılıdır. 

 Dereceleme: Akarsu ağları havzadaki akarsuların derecelendirilerek 

sınıflandırılabileceğini belirtmektedir.  

 Birinci dereceli akarsu: Hiçbir yan kolu olmayan kaynak derelerdir. 

 İkinci dereceli akarsu: Birinci dereceli akarsuların birleştiği nehirlerdir. 

 Üçüncü dereceli akarsu: Birinci ve ikinci dereceli akarsuların birleştiği 

nehirlerdir. 

 Dördüncü dereceli akarsu: birinci, ikinci ve üçüncü dereceli akarsuların 

birleştiği nehirlere (Ana kollar) denilir. 

 

Şekil 2.27: Akım sırasının belirlenmesi. 
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2.4.12 Akarsu Uzunluğu 

ArcToolbox > Conversion Tools > From Raster > Raster To Polyline komutu 

ile havzanın akarsu uzunluğunu belirlemek için akarsuları temsil eden akım toplama 

(flow accumulation) tablosundaki değeri 5000’den küçük olan hücrelerin silinerek 

akarsu tabakalarının raster formatından vektör formatına çevrilmesi gerekmektedir. 

Elde edilen raster formatında uzunluk hesaplanamadığı için akarsuların vektör bir 

tabakada bulunması gerekmektedir. (Şekil 2.28). 

Havza uzunluğu artarsa havza alanı da artar; havza uzunluğu Ana Kanal 

Uzunluğu ile doğrudan ilişkilidir ve toplanma zamanının hesabı için önemlidir. 

Akarsu Akım Uzunluğu aracının birincil kullanımı, belirli bir havza içindeki en uzun 

akım yolunun uzunluğunu hesaplamaktır. Bu ölçü genellikle bir havzanın 

konsantrasyon zamanını hesaplamak için kullanılır. 

Alan parametresi, girdi tarama veri kümesinin hangi öznitelik alanının çıktı 

özelliği sınıfında bir öznitelik haline geleceğini seçmenize olanak tanımaktadır. Bir 

alan belirtilmezse, giriş raster hücre değerleri (değer alanı), çıkış özelliği sınıfının 

öznitelik tablosundaki grid code başlığına sahip bir sütun haline gelecektir. 

 

Şekil 2.28: 4-0.000-10M nolu havzanın vektör formatına çevrilmiş akarsuları. 
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Bir akımın uzunluğu, kaynaktan belirli bir noktaya veya çıkışa akım kanalı 

boyunca ölçülen mesafedir; bir harita üzerinde ölçülebilen bir mesafedir. Büyük 

ölçekli haritalarda geometrik eksen veya maksimum derinlik çizgisi boyunca ölçülür. 

Kaynak, bir akımın başladığı yer olarak kabul edilir ve kural olarak, en küçük çok 

yıllık akımın göründüğü yerle çakışır. Bir nehir kanalının uzunluğunu belirlemek için 

genellikle harita projeksiyonu ölçülür. Havza nehirlerin boyuna profilde çok küçük 

eğimlere sahip olduğu düz bölgeler için geçerlidir.  

Bu çalışmada Strahler sistemi ve akarsu uzunluğunun morfometrik modeli 

kullanılarak nehir uzunluğu analiz edilmektedir. 

 

Şekil 2.29: 4-0.000-10M nolu havzanın kol uzunlukları. 

Kuş uçuşu uzunluk, havza gözlem noktası ile havza ana kolunun başlangıç 

noktasının düz bir çizgi ile birleştirilmesiyle elde edilen uzunluktur. Bu uzunluğun 

hesaplanması için ArcGIS programının “Measure” komutu ile kuş uçuşu uzunluk 

belirlenmektedir. Bu çalışmada 4-0.000-10M numaralı havza için akarsu kuş uçuşu 

uzunluğu (STRL) 39.828475 km olarak ölçülmüştür (Şekil 2.30). 
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Şekil 2.30: 4-0.000-10M nolu havzanın akarsu ana kol kuş uçuşu uzunluğu. 

 

Şekil 2.31: Akarsu uzunluklarının hesaplanması. 
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2.4.13 Akım Uzunluğu (Lt) 

Her bir havzanın ortalama ve toplam akım uzunluğu CBS tekniği kullanılarak 

ölçülür. Akarsu segmentlerinin gelişimini ve yüzey akımı özelliklerini gösterir. 

Nispeten daha küçük akarsu akım uzunluklarına sahip akarsular, alanın yüksek 

eğimli olduğunu gösterir. Daha yüksek akım uzunlukları, daha düz gradyanın 

göstergesidir. 

Strahler (1964) ortalama akım uzunluğu, akım ağının bileşenlerinin 

karakteristik boyutunu tanımlar. Belirli bir sıranın ortalama akım uzunluğu, bir 

sonraki yüksek seviyeden daha az iken, toplam akım uzunluğu birinci sırada 

maksimumdur ve akım sırası arttıkça azalır.  

2.4.14 Eğrilik (Curvature) 

Eğrilik işlevi, havzanın eğim şeklini veya eğriliğini gösterir. Bir yüzeyin bir 

kısmı içbükey veya dışbükey olabilir; bunu eğrilik değerine bakarak anlayabilirsiniz. 

Eğrilik, yüzeyin ikinci türevi hesaplanarak hesaplanır. 

Eğrilik fonksiyonunun çıktısı, erozyon ve akım süreçlerini anlama çabasıyla 

bir drenaj havzasının fiziksel özelliklerini tanımlamak için kullanılabilir. Eğrilik 

değeri, toprak erozyon modellerinin yanı sıra suyun karadaki dağılımını bulmak için 

kullanılabilir. Profil eğriliği, akımın hızlanmasını ve yavaşlamasını etkiler ve bu 

nedenle erozyon ve birikmeyi etkiler. Plan eğriliği, akımın yakınlaşmasını ve 

uzaklaşmasını etkiler. 

 Eğrilik(Curvature): Fonksiyonun üç parametresi vardır. 

 Input Raster: Bu araç, geçici bir katmanı oluşturmak için kullanılabilir; 

böylece bir raster veri kümesi içinde belirli bir bant alt kümesiyle çalışılabilir.  

 Eğrilik Tipi ve Eğrilik türü: Eğimin farklı yönlerini vurgular. Eğrilik Tipi için 

üç seçenek vardır: Profil, plan eğriliği ve standart tahmin hatasıdır. 

Z Faktörü, Z faktörü giriş yüzeyinin x, y birimlerinden farklı olduklarında z 

birimleri için ölçü birimlerini ayarlar x, y birimleri ve z birimleri aynı ölçü 

birimlerindeyse, z faktörü 1’e ayarlanmalıdır. Giriş yüzeyinin z değerleri, son çıktı 

yüzeyi hesaplanırken z faktörü ile çarpılır. Örneğin, z birimleri cm ve x, y birimleri 
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metre ise, z birimlerini santimetreye dönüştürmek için 0,01’lik bir z faktörü 

kullanılır, çünkü 1 cm, 0,01 metreye eşittir. 

Pozitif bir profil eğrilik değeri aldığında havza eğimi paraleldir ve havzanın 

maksimum eğim yönünü gösterir. Yüzey boyunca akımın hızlanmasını ve 

yavaşlamasını etkiler. Yüzey boyunca negatif bir değer, mevcut hücrede yüzeyin 

yukarı doğru dışbükey olduğunu ve akımın yavaşlayacağını gösterir. Eğer yüzey 

boyunca pozitif bir profil değer çıkarsa, yüzeyin o hücrede yukarı doğru içbükey 

olduğunu ve akımın hızlanacağını gösterir. Sıfır değeri aldığında yüzeyin doğrusal 

olduğunu gösterir. 

 

Şekil 2.32: Profile eğriliğin hesaplanması. 
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Longitudinal eğriliği (genellikle plan eğriliği olarak adlandırılır) yüzeyin 

maksimum eğim yönüne diktir. Longitudinal eğriliği, bir yüzey boyunca akımın 

yakınsaması ve uzaklaşması ile ilgilidir. Yüzey boyunca pozitif bir değer aldığında, 

yüzeyin mevcut hücrede yanal olarak dışbükey olduğunu gösterir. Yüzey boyunca 

negatif bir plan, yüzeyin o hücrede yanal olarak içbükey olduğunu gösterir. Sıfır 

değeri aldığında yüzeyin doğrusal olduğunu gösterir. 

 

Şekil 2.33: Longitudinal eğriliği hesaplanması. 
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3. HİDROLOJİK ANALİZ VE TASARIM REGRESYON 

ANALİZİ 

3.1 Genel Bilgiler 

3.1.1 Regresyon Analizinin Amacı 

Regresyon analizi, iki değer kümesi (ölçümler) arasındaki ilişkileri tahmin 

eder. Tahmin edilen değerler (bağımsız) ve gerçek değerler (bağımlı). Regresyon 

analizi, iki değer kümesi arasındaki ilişkiye odaklanır ve bağımsız değişkenlerden 

herhangi biri değiştiğinde bağımlı değişkenin tipik değerinin nasıl değiştiğini 

anlamaya yardımcı olur. 

Regresyon analizi, verilerin bir siteden diğerine aktarılmasına izin veren bir 

araçtır. Regresyon analizi, akarsu akımı ölçümlerini veya havza özelliklerini 

kullanarak bir ilişkiyi tanımlamak için kullanılır. Bu ilişkiden, akım özellikleri 

aktarılabilir. Fen ve sosyal bilimlerde en eski ve muhtemelen en yaygın kullanılan 

çok değişkenli tekniktir. Önceki yöntemlerden farklı olarak regresyon, değişkenlerin 

simetrik olarak ele alınmadığı bir bağımlılık analizi örneğidir. Regresyon analizinde 

amaç, diğerlerinin değerleri verildiğinde bir değişkenin tahminini elde etmektir. Bu 

bakış açısı değişikliğine uyum sağlamak için farklı bir terminoloji ve gösterim 

kullanılmıştır. 

Tahmin edilen değişken genellikle y ile gösterilir ve bağımsız değişkenler, 

birini diğerinden ayırmak için eklenen alt simgeler x ile gösterilir. Doğrusal çoklu 

regresyonda, bağımsız değişkenlerin (genellikle regresyon değişkenlerinin) doğrusal 

bir kombinasyonunu aramaktayız. Örneğin, eğitim araştırmalarında, okul 

performansının ev koşulları, yaş veya önceki bir olaydaki performansa göre ne 

ölçüde tahmin edilebileceğiyle ilgilenebiliriz. 

Uygulamada, regresyon modelleri, uygun yazılım kullanılarak en küçük 

kareler ile tahmin edilir. Önemli pratik konular, en iyi regresyon değişkenlerinin en 

iyi seçimiyle, bunların katsayılarının öneminin test edilmesiyle ve tahminlere güven 

limitlerinin belirlenmesiyle ilgilidir. 
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3.1.2 Parametrelerin Tahmini 

Regresyon analizi, bir sisteme dahil edilen bağımsız (Y) ve bağımlı 

değişkenler (x1, x2, ……, xn) arasındaki ilişkiyi değerlendirmek için yaygın olarak 

kullanılan istatistiksel araçlardan biridir. Bu analizde, genellikle girdi değişkenlerine 

dayalı olarak hedef parametrenin varyasyonunu tatmin edici bir şekilde açıklayabilen 

en iyi karar fonksiyonunu bulmaya çalışır. Ancak bu işlev, seçildiğinde olası 

minimum tahmin hatasına sahip olmalıdır.  

Ampirik riski (hata) en aza indirmek için, bu durumlarda, gerçek ve tahmini 

değerler arasındaki tutarsızlığı ölçmek için εi parametresi tanımlanır. Daha sonra 

toplamı, örneğin en iyi işlevi bulmak için eski moda en küçük kareler yönteminin 

yardımıyla en aza indirilebilir. Bununla birlikte, klasik istatistiksel yaklaşımlar, 

modelle zaten çok iyi açıklanmış olanlar da dahil olmak üzere, tüm veri noktalarını 

analizlerine dahil ettikleri için çok doğru bir tahmin sağlama beklentisini çoğu zaman 

aşmazlar. Bu, girdi alanına birkaç aykırı değer dahil edildiğinde modelin esnekliğini 

kolayca azaltabilir. 

3.2 Basit Doğrusal Regresyon Modeli 

Basit doğrusal regresyonun amacı, bağımsız bir değişkene dayalı olarak 

bağımlı bir değişkenin değerini tahmin etmektir. Bağımsız değişken ile bağımlı 

değişken arasındaki doğrusal ilişki ne kadar büyükse, tahmin o kadar doğru olur. Bu, 

bağımsız değişken tarafından açıklanabilen bağımlı değişkenin varyans oranı ne 

kadar büyükse, tahmin o kadar doğru olur. Görsel olarak, değişkenler arasındaki 

ilişki bir dağılım grafiğinde gösterilebilir. Bağımlı ve bağımsız değişkenler 

arasındaki doğrusal ilişki ne kadar büyükse, veri noktaları o kadar çok düz bir çizgi 

üzerinde bulunur. 

Basit doğrusal regresyonun görevi bağımlı ve bağımsız değişken arasındaki 

doğrusal ilişkiyi en iyi şekilde tanımlayan bu düz çizgiyi tam olarak belirlemektir. 

Doğrusal regresyon analizinde, dağılım grafiğinde düz bir çizgi çizilir. Bu düz 

çizgiyi belirlemek için doğrusal regresyon en küçük kareler yöntemini kullanır 

(Denklem 3.1 ve Denklem 3.2). 
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Regresyon çizgisi aşağıdaki denklemle tanımlanabilir: 

Gerçek İlişki: 

y = B0 + B1x (3.1) 

Basit Doğrusal Regresyon: 

y̍ = b0 + b1x (3.2) 

b0: y ekseni ile kesişme noktasıdır. 

b1: Düz çizginin gradyanıdır. 

Yukarıdaki denklemde y̍ değerinin tahmini, y değerinin ilgili tahminidir. Bu, 

her x değeri için karşılık gelen y değerinin tahmin edildiği anlamına gelir. Tüm 

noktalar (ölçülen değerler) tam olarak tek bir düz çizgi üzerine olursa, tahminimiz 

mükemmel olurdu. Bununla birlikte, bu neredeyse hiçbir zaman böyle değildir. Bu 

nedenle çoğu durumda münferit veri noktalarına mümkün olduğunca yakın olan düz 

bir çizginin bulunması gerekir. Böylelikle, tahmindeki hatayı olabildiğince küçük 

tutmaya çalışır, böylece tahmin edilen değer ile gerçek değer arasındaki mesafe 

mümkün olduğu kadar küçük olur. Bu mesafe veya hataya “artık” denir ve “ɛ” (hata) 

olarak kısaltılır. 

Regresyon doğrusu hesaplanırken geri kalanların karesi toplamının minimum 

olması için regresyon katsayılarını (b0 ve b1) belirlemek için bir girişimde bulunulur. 

Regresyon katsayısı b1 artık farklı işaretlere sahip olabilir ve bu aşağıdaki gibi 

yorumlanabilir. b1 > 0: x ve y arasında pozitif bir korelasyon vardır (x ne kadar 

büyükse, y de o kadar büyük), b1 < 0: x ve y arasında negatif bir korelasyon vardır. 

(x ne kadar büyükse, y o kadar küçük), b1 = 0: x ve y arasında hiçbir korelasyon 

yoktur. Standartlaştırılmış regresyon katsayıları genellikle “beta” harfi ile gösterilir. 

Bunlar birbiriyle karşılaştırılabilir değerlerdir. Burada değişkenin ölçü birimi artık 

önemli değildir. 

3.3 Çoklu Doğrusal Regresyon Modeli 

Basit doğrusal regresyonun aksine, çoklu doğrusal regresyon ikiden fazla 

bağımsız değişkenin dikkate alınmasına izin verir. Amaç, diğer birkaç değişkene 

dayalı olarak bir değişkeni tahmin etmektir. Tahmin edilecek değişken, bağımlı 

değişken olarak adlandırılır. Tahmin için kullanılan değişkenlere bağımsız 
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değişkenler denir. Çoklu doğrusal regresyon, araştırmada da sıklıkla 

kullanılmaktadır. 

Çoklu Regresyon: 

y̍ = b0 + b1x1 + b2x2 + + bkxk (3.3) 

 y̍: Bağımlı değişken, x (veya x1, x2, ..., xk) bağımsız değişkenlerdir. 

 b0: Doğrunun Y ekseni kestiği noktanın değeri 

 b1,2,.n: Doğrunun eğimi 

 b0 ve b 1.2..n: Regresyon katsayıları 

Katsayılar artık doğrusal regresyon denklemine benzer şekilde 

yorumlanabilir. Tüm bağımsız değişkenler 0 ise, ortaya çıkan değer b0’dır. Bağımsız 

bir değişken bir birim değişirse, ilişkili katsayı, bağımlı değişkenin ne kadar 

değiştiğini gösterir. Yani bağımsız değişken xi bir birim artarsa, bağımlı değişken y 

ise bi kadar artar. 

Regresyon modelleri, bağımlı ve bağımsız değişkenler arasındaki mevcut 

ilişkileri, özellikle küçük örneklem büyüklüklerinde, en küçük kareler uydurma 

temelinde araştırmak için uygundur. Bu çalışmada, Helmand Bölgesinden seçilen 11 

adet havza fizyografik parametresi ile debi değerleri arasındaki ilişkiyi doğrusal bir 

fonksiyon olarak modellemek için parametrik çoklu doğrusal regresyon modeli 

kullanılmıştır. 

Parametrik istatistiksel model, değişken bileşenlerin bağımsız olduğunu ve 

gerçek durumla eşleşmeyebileceğini varsayar. En iyi çoklu doğrusal regresyon 

formülasyonu en yüksek çoklu korelasyon katsayısına (R), en düşük standart 

sapmaya ve F oranının büyüklüğüne dayanır ve ayrıca sistemin istatistiksel olarak 

önemli değişkenlerini ortaya çıkarabilir.  
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3.4 Bağımsız Değişkenlerin Modelden Çıkarılması - Adım Adım 

Regresyon 

Yöntem seçimi, bağımsız değişkenlerin analize nasıl girileceğini 

belirlememizi sağlar. Farklı yöntemler kullanarak, aynı değişkenler kümesinden 

çeşitli regresyon modelleri oluşturabiliriz. 

 Giriş (Enter): Bir bloktaki tüm değişkenlerin tek bir adımda girildiği değişken 

seçme işlemidir. 

 Adım Adım (Stepwise): Her adımda, olasılık yeterince küçükse denklemde 

en küçük F olasılığına sahip olmayan bağımsız değişken girilir. Zaten 

regresyon denkleminde bulunan değişkenler, F olasılıkları yeterince büyük 

olursa kaldırılır. Yönteme dahil etmek veya yöntemden çıkarmak için daha 

fazla değişken uygun olmadığında işlem sona erer. 

 Kaldırmak (Remove): Bir bloktaki tüm değişkenlerin tek bir adımda 

kaldırıldığı değişken seçimi prosedürüdür. 

 Geri Eleme (Backward): Tüm değişkenlerin denkleme girildiği ve ardından 

sırayla kaldırıldığı bir değişken seçim işlemidir. Bağımlı değişkenle kısmi 

korelasyonu en küçük olan değişken, işlemden çıkarılmak üzere ilk olarak 

kabul edilir. Eğer eleme kriterini sağlıyorsa kaldırılır. İlk değişken 

çıkarıldıktan sonra, denklemde kalan en küçük kısmi korelasyona sahip 

değişken dikkate alınır. Denklemde kaldırma kriterlerini karşılayan hiçbir 

değişken olmadığında geri eleme işlemi sona erer. 

 İleri Seçim (Forward): Değişkenlerin modele sırayla girildiği kademeli bir 

değişken seçme işlemidir. Denkleme girmek için düşünülen ilk değişken, 

bağımlı değişkenle en büyük pozitif veya negatif korelasyona sahip olandır. 

Bu değişken, yalnızca giriş kriterini karşılıyorsa denkleme girilir. İlk 

değişken girilirse, daha sonra en büyük kısmi korelasyona sahip denklemde 

olmayan bağımsız değişken dikkate alınır. Giriş kriterini karşılayan hiçbir 

değişken olmadığında ileri seçme işlemi sonlandırılır. 

Bu çalışmada, çoklu doğrusal ve geriye doğru eleme süreçlerine dayalı olarak 

bağımlı değişken ile bağımsız değişkenler arasındaki bağlantıları tahmin etmek için 

sağlam bir regresyon modeli geliştirilmiştir. Çoklu doğrusal analiz, diğer bağımsız 

değişkenlerle yüksek düzeyde ilişkili olan değişkenlerin veri setinden çıkarılmasına 
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yardımcı olur ve geriye doğru eliminasyon regresyon analizi, önemsiz değişkenleri 

modelden çıkarır (NCSS, 2017). İşlem sonucunda anlamlılık değerleri, tek bir 

modele uymaya dayanmaktadır.  

Belirtilen giriş yönteminden bağımsız olarak tüm değişkenler denkleme 

girilecek tolerans kriterini geçmelidir. Varsayılan tolerans seviyesi 0.0001’dir. 

Ayrıca, modelde bulunan başka bir değişkenin toleransı, tolerans kriterinin altına 

düşmesine neden olacaksa bir değişken girilmez. Seçilen tüm bağımsız değişkenler 

tek bir regresyon modeline eklenir. Ancak, farklı değişken alt kümeleri için farklı 

giriş yöntemleri belirlenebilir. Örneğin, kademeli seçimi kullanarak regresyon 

modeline bir değişken bloğu ve ileri seçimi kullanarak ikinci bir blok girildiğinde, 

regresyon modeline ikinci bir değişken bloğu eklemek için İleri’ye tıklamak 

gerekmektedir (IBM, 2016). 

3.5 Regresyon Modelinin Performans Analizi 

3.5.1 Belirlilik Katsayısı R
2
  

Belirlilik katsayısı (R-kare), sonuçtaki değişimin ne kadarının bağımsız 

değişkenlerdeki varyasyonla açıklanabileceğini ölçmek için kullanılan istatistiksel bir 

metriktir. Bağımsız değişkenler sonuç değişkeni ile ilişkili olmasa bile, çoklu 

doğrusal regresyon modeline daha fazla bağımsız değişken eklendikçe R
2
 her zaman 

artar (Denklem 3.4). 

R2 =
∑ (y̍ − y̎)n

i=1

∑ (𝑦𝑖 − y̎)n
i=1

 (3.4) 

Burada y̎ incelenen değerlerin ortalaması, n ise veri sayısı, yi incelenen 

değerler, y̍ elde edilen değerlerdir. Dolayısıyla R
2
 tek başına bir modele hangi 

öngörücülerin dahil edilmesi ve hangilerinin hariç tutulması gerektiğini belirlemek 

için kullanılamaz. R
2
 yalnızca 0 ile 1 arasında olabilir; burada 0, sonucun bağımsız 

değişkenlerden herhangi biri tarafından tahmin edilemeyeceğini belirtir ve 1, 

sonucun bağımsız değişkenlerden hatasız olarak tahmin edilebileceğini gösterir. 
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3.5.2 Düzeltilmiş Belirlilik Katsayısı R
2
 

R
2

adj çoklu modellerde genellikle yeterli değildir. Çünkü çoklu regresyon 

modelleri için denkleme yeni değişken ilave edilmesi durumunda R
2
 değeri 

genellikle artmaktadır. Bu yüzden anlamlı bir test yapabilmek için çoklu modellerde 

düzeltilmiş R
2
 hesaplanmalıdır (Denklem 3.5). 

n: Gözlem sayısı 

k: Modeldeki değişken sayısı (bağımsız değişken+bağımlı değişken) 

R
2
 = 1- (1-R

2
) (n-1 / n-k) (3.5) 

Tekli regresyon modellerinde olduğu gibi belirlilik katsayısı 1’e ne kadar 

yakın ise mevcut olan model o kadar uygundur (anlamlıdır). Modelde tahmin edilen 

katsayıların güvenilirliği standart hata ve varyansın küçüklüğüne bakılarak test edilir. 

Bu bize tahmin değerlerinin gerçek değerlere uygunluğu için kısmen bir oran 

vermektedir. Regresyon modelindeki bağımsız değişkenlerin katsayıları modelin 

durumu, anlamlılığı, gücü hakkında bilgi verdiği halde bağımlı ve bağımsız 

değişkenler arasındaki ilişkinin yönünü ve kuvvetini göstermemektedir. Bu nedenle 

korelasyon analizi ile bağımlı ve bağımsız değişken veya değişkenler arasındaki 

ilişkiyi ölçeriz. Görüldüğü gibi eklenen yeni değişkenlere ilişkin ufak uyarlamalar ile 

çoklu regresyon modelleri de tekli regresyon modellerine benzer işlemler ile 

yorumlanabilmektedir. 

3.5.3 Hataların Karelerinin Toplamı SSE 

Hataların karelerinin toplamı veya SSE, gözlemlenen değer ile tahmin edilen 

değer arasındaki farktır. Genellikle hatayı en aza indirmek isteriz. Hata ne kadar 

küçükse, regresyonun tahmin gücü o kadar iyidir (Denklem 3.6). 

SSE = ∑(y𝑖 − y̍
𝑖
)

2
𝑛

𝑖=1

 (3.6) 
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3.5.4 Tahminin Standart Hatası SEE 

Tahminin standart hatası, tahminlerin doğruluğunun bir ölçüsüdür. Regresyon 

çizgisi, tahminin kare sapmalarının toplamını en aza indiren çizgidir (kareler toplamı 

hatası olarak da adlandırılır) (Denklem 3.7).  

SEE = √
SSE

n−2
  (3.7) 
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4. BULGULAR 

Helmand Bölgesinden seçilen havzaların fizyografik parametrelerini 

hesaplayabilmek ve bu parametreleri elde etmek için regresyon analizi yapılmıştır. 

Bu tez kapsamında yer alan 11 havzadan 4-0.000-10M nolu havza üzerinden Bölüm 

2’de detaylı bir şekilde adım adım göstererek 11 havzanın regresyon analizi 

yapılabilmesi için gereken havza fizyografik parametreleri belirlenip Tablo 4.3’te 

gösterilmiştir. Havzaların gereken 30 fizyografik parametreleri, tanımlayıcı 

istatistikleri, Qmaks ve Qort ile Pearson korelasyon katsayıları birlikte verilmiştir. 

Helmand Nehir deşarj ölçümleri 1940’ların ortalarında Afganistan’ın birkaç 

bölgesinde başlamıştır. 1970’lerin sonlarına kadar istasyonların sayısı yıllar içinde 

artmıştır. 1978’e kadar Afganistan’da yaklaşık 160 akım gözlem istasyonundan 

oluşan ağ sistemleri vardı. 1979 ile 1980 yılları arasında akım gözlem istasyonlardan 

hiçbirinden akım akımı verisi toplanmamıştır. 1990 yılında bazı akım gözlem 

istasyonları yeniden kurulmuştur ve şu ana kadar tarihi ağın bazıları yeniden kurulma 

sürecindedir. İki faktörün gelecekteki akım özellikleri üzerindeki etkileri bölgesel 

ölçekte değerlendirilmiştir: İklim değişikliğinin dış faktörü ve büyük ölçekli bir su 

kaynakları projesinin iç faktörüdür. 

Bu çalışmada, Helmand Bölgesinden seçilen havzaların fizyografik 

parametreleri arasında çoklu doğrusal regresyon analizi dördüncü bölümde 

gerçekleştirilmiştir. Aday değişkenler takımından bir dizi bağımsız değişken elde 

edilmiştir. Değişkenlerin alt kümesi elde edildikten sonra, regresyon katsayılarını 

tahmin etmek, artıkları incelemek vb, için çoklu regresyon analizine geçilmelidir. 

Regresyon modelinin performans analizi için ilk başta her bir havza için uzun dönem 

anlık maksimum debi (Qmaks) ve ortalama debi (Qort) ile yüksek korelasyonu olan 

parametreler arasında geriye doğru adım adım regresyon analizi için tüm değişkenler 

model denklemine dahil edilir. Regresyon modelinin her bir aşamasında F değerine 

göre birer tane parametre işlemden çıkartılarak son parametre kalana kadar işlem 

devam ettirilmiştir. Regresyon modelinin performans analizi için gereken 

parametreler (R
2
, R

2
adj ve SEE) SigmaPlot programıyla geriye doğru adım adım 

regresyon analizi sürecinin her aşamasında hesaplanmıştır.  
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Tablo 4.1: Havza fizyografik parametreleri. 

NO Parametrenin 

Sembolü 

Parametrenin Açıklaması 

1 A Havza alanı (km
2
) 

2 P Havza çevre uzunluğu (km
2
) 

3 GX Havza ağırlık merkezinin X koordinatı 

4 GY Havza ağırlık merkezinin Y koordinatı 

5 SLP Havza eğimi 

6 AGI_KOT Havzadaki akım gözlem istasyonunun kotu 

7 G_AGI 
Havza ağırlık merkezinin havza çıkış noktası arasında kuş uçuşu 

mesafesi 

8 E1 Havzanın kot-rölyef oranı 

9 H_MAX 
Havzanın sayısal yükseklik modelinden elde edilen Maksimum 

kot değeri 

10 H_ORT 
Havzanın sayısal yükseklik modelinden elde edilen Minimum kot 

değeri 

11 PROF_MIN Havzaya ait çıkarılmış SYM’nin minimum profil eğriliği 

12 PROF_MAX Havzaya ait çıkarılmış SYM’nin maksimum profil eğriliği 

13 LONG_MIN Havzaya ait çıkarılmış SYM’nin minimum boyuna profil eğriliği 

14 LONG_MAX Havzaya ait çıkarılmış SYM’nin maksimum boyuna profil eğriliği 

15 L_ANAKOL Havzanın akarsu ana kol uzunluğu 

16 L_KUŞUÇ Havzanın akarsu ana kol kuş uçuşu uzunluğu 

17 SIN 
Sinüzoite akarsu, ana kol uzunluğunun akarsu ana kol kuş uçuşu 

uzunluğuna oranı 

18 AGI_X Akım gözlem istasyonunun X koordinatları 

19 AGI_Y Akım gözlem istasyonunun Y koordinatları 

20 STR 
Havzanın çıkarılmış akım toplama haritasından elde edilen 

Strahler (Akarsu Çatallanma Oranı) 

21 SHR 
Havzanın çıkarılmış akım toplama haritasından elde edilen Shreve 

(Akarsu Çatallanma Oranı) değeri 
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Tablo 4.2: Havza fizyografik parametreleri (Devam). 

NO Parametrenin 

Sembolü 

Parametrenin Açıklaması 

22 BAKI_DÜZ 
Havzaya ait bakı haritasında -1° de hücre sayısının, tüm hücre 

sayısına bölünmesiyle bulunan oran 

23 BAKI_K 
Havzaya ait bakı haritasında 0°- 22.5° arasında kalan hücre 

sayısının, tüm hücre sayısına bölünmesiyle bulunan oran 

24 BAKI_KD 
Havzaya ait bakı haritasında 22.5°- 67.5° arasında kalan hücre 

sayısının, tüm hücre sayısına bölünmesiyle bulunan oran 

25 BAKI_D 
Havzaya ait bakı haritasında 67.5°-112.5° arasında kalan hücre 

sayısının, tüm hücre sayısına bölünmesiyle bulunan oran 

26 BAKI_GD 
Havzaya ait bakı haritasında 112.5°-157.5° arasında kalan hücre 

sayısının, tüm hücre sayısına bölünmesiyle bulunan oran 

27 BAKI_G 
Havzaya ait bakı haritasında 157.5°-202.5° arasında kalan hücre 

sayısının, tüm hücre sayısına bölünmesiyle bulunan oran 

28 BAKI_GB 
Havzaya ait bakı haritasında 202.5°- 247.5° arasında kalan hücre 

sayısının, tüm hücre sayısına bölünmesiyle bulunan oran 

29 BAKI_B 
Havzaya ait bakı haritasında 247.5°- 292.5° arasında kalan hücre 

sayısının, tüm hücre sayısına bölünmesiyle bulunan oran 

30 BAKI_KB 
Havzaya ait bakı haritasında 292.5°- 337.5° arasında kalan hücre 

sayısının, tüm hücre sayısına bölünmesiyle bulunan oran 

 

Tablo 4.3: Parametrelerin tanımlayıcı istatistikleri ve Qmaks ve Qort ile Pearson 

korelasyon katsayıları. 

Parametre Ortalama 
Standart 

Sapma 
Maks Min 

Pearson 

Korelasyon 

Katsayıları 

Qmaks Qort 
A 12038.6755 16142.747 46686.4 155.453 0.987 0.816 

P 636.610736 592.67965 1737.49 65.5941 0.984 0.730 

AGİ_KOT 1816.9091 808.85146 3030 964 -0.722 -0.437 

GX 303567.909 81166.897 449112 170043 -0.488 -0.269 

GY 3744129.18 73256.381 3832178 3629568 -0.178 -0.122 

AGİ_X 265527 105185.67 432377 134298 -0.709 -0.489 

AGİ_Y 3697660.51 92963.877 3825333 3583199 -0.629 -0.469 

G_AGİ 71.4144 59.89778 186.89 9.023 0.967 0.746 

SLP 18.888182 1.9256262 21.901 14.76 0.106 0.017 

H_MAX 4356.1118 703.0757 5064 2692.23 -0.229 0.237 

H_ORT 3108.1527 801.202 5064 2169.43 0.233 -0.127 

BAKI_DÜZ 0.002817 0.001552 0.005419 0.000668 0.714 0.620 

BAKI_K 0.072314 0.00523 0.083883 0.062579 0.024 0.064 

BAKI_KD 0.116971 0.023267 0.168119 0.087396 -0.236 -0.105 

BAKI_D 0.113647 0.021218 0.155484 0.096053 0.224 -0.042 

BAKI_GD 0.14764 0.019443 0.173987 0.107514 -0.274 0.004 
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Tablo 4.4: Parametrelerin tanımlayıcı istatistikleri ve Qmaks ve Qort ile Pearson 

korelasyon katsayıları (Devam). 

Parametre Ortalama 
Standart 

Sapma 
Maks Min 

Pearson 

Korelasyon 

Katsayıları 
Qmaks Qort 

BAKI_G 0.164106 0.009965 0.181244 0.144386 0.086 -0.012 

BAKI_GB 0.128891 0.011571 0.152413 0.105945 0.044 0.053 

BAKI_B 0.112632 0.01455 0.130834 0.077464 0.092 0.053 

BAKI_KB 0.140981 0.020422 0.174245 0.107152 0.103 0.035 

E 0.385136 0.0600725 0.4634 0.2745 0.368 0.081 

STR 10.27 1.272 12 8 0.958 0.710 

SHR 838.75 729.8433 2164.98 83.55 0,958 0.710 

L_ANA KOL 205.70005 193.24051 597.3511 28.1379 0.967 0.777 

L_KUŞ UÇ 147.64207 140.43855 418.1458 17.7269 0.967 0.749 

SIN 1.419185 0.1073068 1.5873 1.2987 -0.216 -0.025 

PROF_MİN -1.6440E+11 2.8673E+10 -9.490E+10 -1.975E+11 -0.567 -0.434 

PROF_MAX 1.7676E+11 4.63113E+10 2.33E+11 8.84E+10 0.835 0.512 
LONG_MİN -1.8609E+11 3.93254E+10 -1.08E+11 -2.22E+11 -0.670 -0.387 

LONG_MAX 1.7409E+11 3.43612E+10 2.11E+11 1.05E+11 0.739 0.447 
QMAX 623.5454 784.9388 2155 21.5 1.00 0.744 
QORT 131.4436 312.9112 1060 1.6 0.744 1.00 

 

Basit lineer regresyon, çoklu lineer regresyon, lojistik regresyon, sıralı 

regresyon, çok terimli ve tanımlayıcı regresyon analizi olmak üzere istatistikler de 

mevcut olan altı tip lineer regresyon analizi vardır. Çoklu doğrusal regresyon, tek 

yanıt değişkeni (bağımlı değişken) ile iki veya daha fazla kontrollü değişken 

(bağımsız değişken) arasındaki ilişkiyi analiz etmek için kullanılan doğrusal 

regresyon analizlerinden biridir.  

Bu çalışmada, adım adım çoklu regresyon kullanılmıştır çünkü bu yöntem 

ileri seçim ve geriye doğru eleme yönteminin birleşimidir. Bu tezde, seçilen 11 adet 

havzanın her birinin havza fizyografik parametrelerinin orijinal değerleriyle Qmaks ve 

Qort arasında yapılan regresyon modellerinin performans parametrelerinin modellere 

göre değişim göstererek en iyi modelin hangisi olduğu gösterilmiştir. Bu araştırmada 

kullanılan veriler, Helmand Bölge fizyografik parametreleri yıllık istatistiklerinden 

alınmıştır. Daha sonra veriler SigmaPlot programı kullanılarak analiz edilmiştir. 

SigmaPlot programıyla regresyon analizi için CBS programı aracılığıyla her 

havza için 30 adet fizyografik parametre elde edilmiştir. Regresyon analizi yapmak 
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için CBS programı üzerinden her havza için bulduğumuz 30 adet parametre ile her 

bir havzanın Qmaks ve Qort değerleri arasında yüksek korelasyonu olan parametreler 

belirlenmiştir. Qmaks ve Qort ile Tablo 4.6’da verilen en yüksek korelasyona sahip olan 

parametreler arasında SigmaPlot programıyla regresyon analizi yapılmıştır. 

Kullanıcı, değişkenlerin modele girebileceği önem düzeyini ayarlar. Geriye doğru 

seçim modeli, modeldeki tüm aday değişkenlerle başlar. Her adımda en az anlamlı 

olan değişken (F) işlemden kaldırılır. Bu işlem anlamsız değişken kalmayana kadar 

devam eder. Kullanıcı, değişkenlerin modelden çıkarılabileceği önem düzeyini 

belirler. Tablo 4.5’te Havza fizyografik parametreleri ile Qmaks ve Qort arasında en 

yüksek korelasyonu olan parametreler arasında geriye doğru adım adım regresyon 

analizi yapılmıştır. Analizde Qmaks ve Qort ile en yüksek korelasyon olan 

parametrelerin her biri için kaldırılan adım sayıları ve en iyi model katsayıları 

belirlenmiş ve aşağıdaki Tablo 4.6’da gösterilmiştir. 

Tablo 4.5: Havza fizyografik parametreleri ile Qmaks ve Qort arasında en yüksek 

korelasyonu olan parametreler. 

NO Parametrenin 

Sembolü 

Pararmetrenin Açıklaması 

1 A Havza alanı (km
2
) 

2 P Havza çevre uzunluğu (km
2
) 

3 AGİ_KOT Havzadaki akım gözlem istasyonunun kotu 

4 
G_AGİ Havza ağırlık merkezinin havza çıkış noktası arasında kuş 

uçuşu mesafesi 

5 AGİ_X Akım gözlem istasyonunun X koordinatları 

6 AGİ_Y Akım gözlem istasyonunun Y koordinatları 

7 
SHR Havzanın çıkarılmış akım toplama haritasından elde edilen 

Shreve (Akarsu Çatallanma Oranı) 

8 L_ANA KOL Havzanın akarsu ana kol uzunluğu 

9 L_KUŞ UÇ Havzanın akarsu ana kol kuş uçuşu uzunluğu 
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Tablo 4.6: Parametrelerin kaldırıldığı adım numaraları ve en iyi modellerin 

katsayıları. 

Parametre 

Qmaks için 

kaldırıldığı 

adım sayısı 

Qmaks için en 

iyi modelin 

katsayıları 

Qort için 

kaldırıldığı 

adım sayısı 

Qort için en 

iyi modelin 

katsayıları 
SABİT  86.919  -120.464 

A  0.0583 6  

P 5 -1.261 1  

AGİ_KOT 2  5  

G_AGİ 3  2  

AGİ_X 1  3  

AGİ_Y 4  4  

SHR 8 1.067 7 -0.415 

L_ANA KOL 6 -11.981  18.461 

L_KUŞ UÇ 7 15.286 8 -21.666 

 

 

Şakil 4.1: Qmaks için performans analizi. 
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Şakil 4.2: Qort için performans analizi. 

Bir havzanın çeşitli fizyografik parametrelerinin ArcGIS yazılımı kullanılarak 

hesaplanmasının ve buna ait sonuçların değerlendirilmesi amacıyla Afganistan’da 

yer alan havzalar taranmış olup yapılan inceleme neticesinde 20 yıl ve daha fazla 

süre ölçüm değerine sahip istasyonların mevcut olması sebebiyle Afganistan 

Helmand Bölgesi uygulama alanı olarak seçilmiştir. Uygulama alanında akım 

gözlem istasyonu olan 11 adet alt havza için Tablo 4.1 ve Tablo 4.2’de gösterildiği 

gibi toplamda 30 adet havza fizyografik parametresi CBS yazılımı ile belirlenmiştir. 

Regresyon modelinin performans analizi için ilk başta her bir havza için uzun dönem 

anlık maksimum debi (Qmaks) ve ortalama debi (Qort) ile yüksek korelasyonu olan 

Tablo 4.5’te gösterdiği gibi 9 adet fizyografik parametre belirlenmiştir. Geriye doğru 

adım adım regresyon analizinde seçilen 9 adet fizyografik parametreden Qmaks için en 

iyi modelin katsayıları; Havza alanı (A), Havzanın çıkarılmış akım toplama 

haritasından elde edilen Shreve (SHR), Havzanın akarsu ana kol uzunluğu (L_ANA 

KOL), Havzanın akarsu ana kol kuş uçuşu uzunluğu (L_KUŞ UÇ) ve Qort için en iyi 

modelin katsayıları; Havza alanı (A), Havzadaki akım gözlem istasyonunun kotu 

(AGİ_KOT), Akım gözlem istasyonunun Y koordinatları (AGİ_Y), Havzanın 

çıkarılmış akım toplama haritasından elde edilen Shreve (SHR), Havzanın akarsu ana 

kol uzunluğu (L_ANA KOL) olarak Tablo 4.6’da gösterilmiştir. En iyi modelin 

seçiminde belirlilik katsayısı (R
2
), düzeltilmiş belirlilik katsayısı (R

2
adj) ve Standart 

Tahmin Hatası (SEE) değişimi ile Qmaks ve Qort arasında geriye doğru adım adım 
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regresyon analizi sonucunda en iyi modelin hangisi olduğu Şekil 4.1 ve Şekil 4.2’de 

gösterilmiştir. Şekil 4.1 ve Şekil 4.2’de gösterildiği gibi Qmaks için 5 parametreli ve 

Qort için 3 parametreli olan modeller en iyi modeller olarak gösterilmiştir.  

Benzer işlem, parametrelerin küp köklerinin tersleri alınarak elde edilen 

değerler için de yapılmış ve Tablo 4.7’de gösterilmiştir. 

Tablo 4.7: Parametrelerin küpköklerinin terslerinin tanımlayıcı istatistikleri ve Qmaks 

ve Qort ile aralarındaki Pearson korelasyon katsayıları. 

Parametre Ortalama 
Standart 

Sapma 
Maks Min 

Pearson 

korelasyon 

Katsayıları 
Qmaks Qort 

A 0.076 0.048 0.186 0.028 0.973 0.961 

P 0.145 0.053 0.248 0.083 0.971 0.972 

AGİ_KOT 0.085 0.012 0.101 0.069 -0.875 -0.883 

GX 0.015 0.001 0.018 0.013 -0.744 -0.68 

GY 0.006 4.22E+5 0.007 0.006 -0.57 -0.433 

AGİ_X 0.016 0.002 0.030 0.013 -0.86 -0.871 

AGİ_Y 0.007 5.39E+5 0.007 0.007 -0.826 -0.775 

G_AGİ 0.287 0.095 0.481 0.175 0.952 0.951 

SLP 0.377 0.0138 0.409 0.358 -0.13 -0.012 

H_MAX 0.062 0.004 0.072 0.058 -0.359 -0.278 

H_ORT 0.069 0.005 0.077 0.058 -0.267 -0.186 

BAKI_DÜZ 7.713 1.921 11.263 5.701 0.892 0.864 

BAKI_K 2.403 0.058 2.519 2.284 -0.456 -0.303 

BAKI_KD 2.061 0.128 2.253 1.812 -0.683 -0.525 

BAKI_D 2.077 0.112 2.183 1.860 -0.313 -0.195 

BAKI_GD 1.901 0.093 2.103 1.791 -0.001 -0.082 

BAKI_G 1.828 0.037 1.906 1.767 0.442 0.424 

BAKI_GB 1.983 0.061 2.114 1.872 0.21 0.247 

BAKI_B 2.079 0.102 2.346 1.97 0.577 0.461 

BAKI_KB 1.930 0.094 2.105 1.791 0.678 0.522 

E 1.382 0.078 1.539 1.292 0.623 0.558 

STR 0.462 0.021 0.500 0.4368 0.909 0.953 

SHR 0.131 0.049 0.229 0.077 0.963 0.948 

L_ANA KOL 0.20 0.069 0.329 0.119 0.917 0.924 

L_KUŞ UÇ 0.233 0.081 0.384 0.134 0.937 0.94 

SIN 0.891 0.022 0.917 0.857 -0.45 -0.417 

PROF_MİN -1.84E+4 1.34E+5 -1.72E+4 -2.19E+4 -0.573 -0.584 

PROF_MAX 2.01E+4 2.01E+5 2.24E4 1.63E+4 0.785 0.816 

LONG_MİN -2.01E+4 1.01E+5 -1.65E+4 -2.1E+4 -0.877 -0.836 

LONG_MAX 2.01E+4 1.01E+5 2.12E+4 1.68E+4 0.893 0.869 

QMAX 0.169 0.089 0.361 0.077 1 0.966 

QORT 0.412 0.212 0.821 0.098 0.966 1 
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Benzer işlem, parametrelerin küp köklerinin tersleri alınarak elde edilen 

değerler için de yapılmıştır. SigmaPlot programı ile regresyon analizi için CBS 

programı aracılığıyla her havza için 30 adet fizyografik parametre elde edilmiştir. 

Regresyon analizi yapmak için ArcGIS programı üzerinden bulduğumuz 30 adet 

fizyografik parametre ile her bir havzanın Qmaks ve Qort değerleri arasında yüksek 

korelasyona sahip parametreler belirlenmiştir. Qmaks ve Qort ile Tablo 4.8’de verilen 

en yüksek korelasyona sahip olan parametreler arasında SigmaPlot programı ile 

regresyon analizi yapılmıştır. Qmaks ve Qort ile seçtiğimiz yüksek korelasyonu olan 

parametreler arasında regresyon analizi sonucunda elde ettiğimiz Qmaks ve Qort ile 

yüksek korelasyonu olan parametrelerin her biri için kaldırılan adım sayıları ve en iyi 

model katsayıları belirlenip aşağıdaki Tablo 4.8’de gösterilmiştir. 

Tablo 4.8: Parametrelerin küp köklerinin tersleri ile yapılan regresyon analizinin 

sonuçları. 

Parametre 

Qmaks için 

kaldırıldığı 

adım sayısı 

Qmaks için en 

iyi modelin 

katsayıları 

Qort için 

kaldırıldığı 

adım sayısı 

Qort için en 

iyi modelin 

katsayıları 
SABİT  -0.304  0.493 

A 3  4  

P  2.084 1  

AGİ_KOT 8 2.014 3  

G_AGİ 2  2  

AGİ_X 6  7 -29.033 

AGİ_Y 1  6  

SHR 5  5  

L_ANA KOL 7  8 -6.265 

L_KUŞ UÇ 4   7.223 
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Şakil 4.3: Qmaks için performans analizi. 

 

Şakil 4.4: Qort için performans analizi. 

Benzer işlemler parametrelerin küp köklerinin tersi alınarak elde edilen 

değerler için de yapılmıştır. Regresyon modelinin performans analizi için ilk başta 

her bir havza için uzun dönem anlık maksimum debi (Qmaks) ve ortalama debi (Qort) 

ile yüksek korelasyonu olan Tablo 4.5’te gösterdiği gibi 9 adet fizyografik parametre 

belirlenmiştir.  
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Regresyon analizde seçilen 9 adet fizyografik parametreden Qmaks için en iyi 

modelin katsayıları; Havza alanı (A), Havza çevre uzunluğu (P), Havzadaki akım 

gözlem istasyonunun kotu (AGİ_KOT), Akım gözlem istasyonunun X koordinatları 

(AGİ_X), Akım gözlem istasyonunun Y koordinatları (AGİ_Y), Havzanın akarsu 

ana kol uzunluğu (L_ANA KOL), Havzanın akarsu ana kol kuş uçuşu uzunluğu 

(L_KUŞ UÇ) ve Qort için en iyi modelin katsayıları; Havza alanı (A), Havza çevre 

uzunluğu (P), Havzadaki akım gözlem istasyonunun kotu (AGİ_KOT), Havza ağırlık 

merkezinin havza çıkış noktası arasında kuş uçuşu mesafesi (G_AGİ), Havzanın 

akarsu ana kol uzunluğu (L_ANA KOL), Havzanın akarsu ana kol kuş uçuşu 

uzunluğu (L_KUŞ UÇ) olarak Tablo 4.8’de gösterilmiştir. En iyi modelin seçiminde 

belirlilik katsayısı (R
2
), düzeltilmiş belirlilik katsayısı (R

2
adj) ve Standart Tahmin 

Hatası (SEE) değişimi ile Qmaks ve Qort arasında geriye doğru adım adım regresyon 

analizi sonucunda en iyi modelin hangisi olduğu Şekil 4.3 ve Şekil 4.4’te gösterildiği 

gibi Qmaks için 2 parametreli ve Qort için 3 parametreli olan modeller en iyi modeller 

olarak gösterilmiştir. 



71 

 

5. SONUÇ VE ÖNERİLER 

Bu çalışmada Helmand Bölgesinden seçilen 11 adet Havzanın her birinden 

elde edilen anlık maksimum debi (Qmaks) ve ortalama debi (Qort) değerleri ile havza 

fizyografik parametreleri arasında çeşitli doğrusal modeller incelenmiştir.  

ArcGIS yazılımı kullanılarak hesaplanan Tablo 4.1 ve Tablo 4.2’de 

gösterildiği gibi 30 adet havza fizyografik parametresinden regresyon modelinin 

performans analizi sonuçlarının değerlendirilmesi için etkili havza fizyografik 

parametreleri; Havza alanı (A), Havza çevre uzunluğu (P), Havzadaki akım gözlem 

istasyonunun kotu (AGİ_KOT), Havza ağırlık merkezinin havza çıkış noktası 

arasında kuş uçuşu mesafesi (G_AGİ), Havzanın çıkarılmış akım toplama 

haritasından elde edilen Shreve (SHR), Havzanın akarsu ana kol uzunluğu (L_ANA 

KOL), Havzanın akarsu ana kol kuş uçuşu uzunluğu (L_KUŞ UÇ)’dan Qmaks ve Qort 

için en iyi modelin katsayıları Tablo 4.6 ve Tablo 4.8’da gösterilmiştir. 

Analizde seçilen 11 havza için sayısal yükseklik modelinden elde ettiğimiz 

30 adet havza fizyografik parametresinden 9 adet parametre kullanılmıştır. Tablo 

4.5’te gösterdiği gibi Qmaks ve Qort ile en yüksek pozitif veya negatif korelasyonu 

olan 9 adet havza fizyografik parametre belirlenmiştir. Qmaks ve Qort ile Tablo 4.6’da 

verilen en yüksek korelasyona sahip olan parametreler arasında SigmaPlot 

programıyla geriye doğru adım adım regresyon analizi yapılmıştır. Analizde ilk önce 

bütün parametreler seçilmiştir. Sonra sıra ile parametrelerin formülden kaldırabilmesi 

için en küçük kareler (F) değerine göre eleme yapılmıştır. İlk önce en küçük kısmi 

korelasyon katsayısına sahip parametre incelenir. Öngörülen değerlerden, büyük 

değere sahip parametre elenir. Geriye doğru kademeli bir şekilde doğrusal regresyon 

analizi ile doğrusal modeller sistematik olarak oluşturulmuştur.  

Tablo 4.6’da gösterdiği gibi anlık maksimum debi (Qmaks) ve ortalama debi 

(Qort) değerleri ile havza fizyografik parametreleri arasında doğrusal olmayan ilişki 

görünmektedir. Bu çalışmada doğrusal regresyon analizi yapıldığı için Qmaks ve Qort 

değerleri ile havza fizyografik parametreleri arasında daha doğrusal ilişkileri bulmak 

için doğrusallaştırma yöntemlerinden “Parametrelerin küp köklerinin tersi” yöntemi 

ile yapılan doğrusal regresyon analizinde daha başarılı sonuçlar elde edilmiştir.  
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En iyi modelin seçiminde SigmaPlot programıyla Qmaks ve Qort ile en yüksek 

korelasyonu olan 9 adet parametre ile geriye doğru adım adım regresyon analizi 

sonucunda belirlilik katsayısının (R
2
), düzeltilmiş belirlilik katsayısı (R

2
adj) ve 

Standart Tahmin Hatası (SEE) yanında daha az etkili olduğunu göstermektedir. 

Geriye doğru adım adım regresyon analizinin her modelde parametre sayısı değiştiği 

için düzeltilmiş belirlilik katsayısı ve standart tahmin hatası değişimi kullanılmalıdır. 

Arasında yüksek korelasyon olan iki veya daha fazla havza fizyografik 

parametresinin regresyon analizinde kullanılması çoklu bağlantı oluşturmaktadır. Bu 

bağlantı, modeldeki küçük değişikliklere veya regresyon analizindeki verilere yanıt 

olarak katsayı tahminlerinin düzensiz bir şekilde değişmesine yol açmaktadır. Olası 

tüm regresyon modelleri denenebilir ancak 30 adet fizyografik parametre için bir 

milyardan fazla alternatif ortaya çıkar (2
n
-1), bu nedenle bu teknik bazı 

parametrelerin ortadan kaldırılmasından sonra uygulanmalıdır. Doğrusal olmayan 

regresyon veya yapay sinir ağları gibi diğer model oluşturma teknikleri en iyi modeli 

elde etmek için gelecekteki çalışmalarda gerçekleştirilebilir. 

Bu çalışma, iklim değişikliğinin uzun vadeli etkilerini dikkate almak için 

hidrolojik modele dayalı yüzey akım analizlerini içermektedir. Bu çalışmanın 

sonuçlarının gelecekteki su kaynakları yönetimi planlarının oluşturulması ve ilgili 

projelerin değerlendirilmesi için temel veriler olarak faydalı olması beklenmektedir 

Helmand Nehri akım verilerinin analizi, birkaç sonuca yol açar. Her birine birkaç 

veri analizi prosedürünün sonuçlarıyla desteklenen sonuçlar sunulmaktadır. 

Bu çalışmada, akım özelliklerini belirlemek için kullanılan analitik yöntemler 

ve bu yöntemlerin uygulanmasından elde edilen sonuçlar açıklanmaktadır. Bu 

yöntemler; frekans analizi, akım süresi, ortalama akım analizi ve regresyon 

analizidir. Akarsu akımı karakteristikleri, mevcut veriler ve akarsu akımı 

karakteristiklerinin çeşitli yöntemlerle hesaplanması ile ilgili tartışmalar 

sunulmuştur. Doğal akarsu akımı oldukça değişkendir ve belirli bir bölgenin 

jeolojisine, iklimine ve topografyasına bağlıdır. Akarsu akım karakteristikleri, akarsu 

akımının anlık, günlük, aylık ve yıllık ortalamalarının büyüklüğü, değişkenliği ve uç 

noktalarının nicel ölçümleridir. Çoğu akarsu akımının karakteristiği, genellikle düşük 

veya yüksek akım özellikleri olarak kategorize edilebilir. 
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7. EKLER 

EK A: Afganistan Helmand Bölgesinden seçilen havzaların haritaları. 

 

Şekil A. 1: 4-0.000- 7M Numaralı havzanın haritası. 
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Şekil A. 2: 4-5.L00-4A Numaralı havzanın haritası. 
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Şekil A. 3: 4-5.L00-4A Numaralı havzanın haritası. 
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Şekil A. 4: 4-000-6M Numaralı havzanın haritası. 
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Şekil A. 5: 4-0.00R-14 Numaralı havzanın haritası. 
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Şekil A. 6: 4-1.21.R.5T Numaralı havzanın haritası. 
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Şekil A. 7: 3-4.L00-7A Numaralı havzanın haritası. 
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Şekil A. 8: 4-13.R00-4A Numaralı havzanın haritası. 
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Şekil A. 9: 4-14.R00-1A Numaralı havzanın haritası. 
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Şekil A. 10: 4-0.000-10M Numaralı havzanın haritası. 
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Şekil A. 11: 4-16.R00-3A Numaralı havzanın haritası. 
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